Projector

P502HL-2/P502WL-2

User’s Manual

Please visit our website for User’s Manual in the latest version.

Model No.
NP-P502HL-2, NP-P502WL-2
NOTES

(1) The contents of this user’s manual may not be reprinted in part or whole without permission.
(2) The contents of this user’s manual are subject to change without notice.
(3) Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable points, errors or omissions, please contact us.
(4) Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed to result from using the Projector.
Important Information

Safety Cautions

Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this unit has been provided. The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus complies with Canadian ICES-003.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic products carrying the mark (left) must be disposed of separately from normal household waste. This includes projectors and their electrical accessories. When you dispose of such products, please follow the guidance of your local authority and/or ask the shop where you purchased the product.

After collecting the used products, they are reused and recycled in a proper way. This effort will help us reduce the wastes as well as the negative impact to the human health and the environment at the minimum level. The mark on the electrical and electronic products only applies to the current European Union Member States.

For EU: The crossed-out wheeled bin implies that used batteries should not be put to the general household waste! There is a separate collection system for used batteries, to allow proper treatment and recycling in accordance with legislation.

According the EU directive 2006/66/EC, the battery can’t be disposed improperly. The battery shall be separated to collect by local service.
RF Interference (for USA only)

**WARNING**
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regulation could void your right to operate this equipment. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (15 Amps) fuse installed for use with this equipment. If a power cord is not supplied with this equipment please contact your supplier.

**Important Safeguards**

These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them carefully and heed all warnings.

**Installation**

- Do not place the projector in the following conditions:
  - Outdoors
  - on an unstable cart, stand, or table.
  - near water, baths, or damp rooms.
  - in direct sunlight, near heaters, or heat radiating appliances.
  - in a dusty, smoky or steamy environment.
  - on a sheet of paper or cloth, rugs or carpets.
- Do not install and store the projector in the below circumstances. Failure to do so may cause of malfunction.
  - In powerful magnetic fields
  - In corrosive gas environment
- If you wish to have the projector installed on the ceiling:
  - Do not attempt to install the projector yourself.
  - The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
  - In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes.
  - Please consult your dealer for more information.
Important Information

**WARNING**
- Do not cover the lens with the lens cap or equivalent while the projector is on. Doing so can lead to melting of the cap due to the heat emitted from the light output.
- Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead to the object melting from the heat that is emitted from the light output.

Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the cabinet and the lens. It may cause of fire.

Do not use the projector with it leaning to the left and right. This may result in a malfunction, however, portrait installation* is possible. For portrait installation, install the projector with the intake vent at the bottom. Observe precautions for portrait installation.
- A customized stand needs to be fixed together with the projector. (→ page 86)

**Fire and Shock Precautions**
- Do not obstruct the projector’s ventilation holes. Also, do not place paper, cloth or other soft objects under the projector. Doing so could cause fire. Install the projector in a place where it will have sufficient space around it (approximately 100 mm or more for the ventilation intake, 200 mm or more for the exhaust vent).
- Do not try to touch the exhaust vent as it can become heated while the projector is turned on and immediately after the projector is turned off. Parts of the projector may become temporarily heated if the projector is turned off with the POWER button.
- Be careful for handling the projector.
- Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately and have the object removed by a qualified service personnel.
- Do not place any objects on top of the projector.
- Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
- The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply fits this requirement before attempting to use your projector.
- Do not look into the lens while the projector is on. Serious damage to your eyes could result.
- Do not look into the light source using optical instruments (such as magnifying glasses and mirrors). Visual impairment could result.
- Keep any items (magnifying glass etc.) out of the light path of the projector. The light path being projected from the lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause an unpredictable outcome such as a fire or injury to the eyes.
- Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent. Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the exhaust.
- Do not splash water over the projector. Doing so can cause electrical shock or fire. If the projector gets wet, turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel.
- Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
  - Do not use any power cord other than the one supplied with the projector.
  - Do not bend or tug the power cord excessively.
Important Information

- Do not place the power cord under the projector, or any heavy object.
- Do not cover the power cord with other soft materials such as rugs.
- Do not heat the power cord.
- Do not handle the power plug with wet hands.

**Remote Control Precautions**

- Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under the following conditions:
  - When the power cord or plug is damaged or frayed.
  - If liquid has been spilled into the projector, or if it has been exposed to rain or water.
  - If the projector does not operate normally when you follow the instructions described in this user's manual.
  - If the projector has been dropped or the cabinet has been damaged.
  - If the projector exhibits a distinct change in performance, indicating a need for service.
- Disconnect the power cord and any other cables before carrying the projector.
- Turn off the projector and unplug the power cord before cleaning the cabinet.
- Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
- When using a LAN cable:
  - For safety, do not connect to the terminal for peripheral device wiring that might have excessive voltage.

**CAUTION**

- Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come off and fall, resulting in injury or damage to the cable cover.
- Do not put bundled cables in the cable cover. Doing so may damage the power cord, resulting in a fire.
- Do not hold the cable cover while moving the projector or do not apply excessive force to the cable cover. Doing so may damage the cable cover, resulting in injury.
- Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hanging on the wall can cause damage to the projector.
- Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the soft case could be damaged.
- Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select [SETUP] → [OPTIONS(1)] → [FAN MODE] → [HIGH].)

**Remote Control Precautions**

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries' polarity (+/-) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.
Light Module

1. A light module containing multiple laser diodes is equipped in the product as the light source.
2. These laser diodes are sealed in the light module. No maintenance or service is required for the performance of the light module.
3. End user is not allowed to replace the light module.
4. Contact qualified distributor for light module replacement and further information.

Laser Safety Caution

- The laser module is equipped in this product. Use of controls or adjustments of procedures other than those specified herein may result in hazardous radiation exposure.
- This product is classified as Class 1 of IEC60825-1 Third edition 2014-05. This product is classified as Class 2 of IEC60825-1 Second edition 2007-03. Also complies with FDA performance standards 21 CFR 1040.10 and 1040.11 for laser products except for deviations pursuant to Laser Notice No. 50, dated June 24, 2007.
- Obey the laws and regulations of your country in relation to the installation and management of the device.
- Blue laser diodes: Wave length 455 nm, Output power 120 W
- Do not look into the lens while the projector is on. Serious damage to your eyes could result. Pay enough attention to children.
- The below diagram is indicated on the projector.

• Do not look into the light source using optical instruments (such as magnifying glasses and mirrors). Visual impairment could result.
• When turning on the projector, make sure no one within projection range is looking at the lens.
DO NOT STARE INTO THE LENS WHILE IN USE.
The labels are stuck on the below indicated position.

Label 1:

Label 2:

CAUTION
POSSIBLY HAZARDOUS OPTICAL RADIATION
EMITTED FROM THIS PRODUCT.
DO NOT STARE AT OPERATING LAMP.
MAY BE HARMFUL TO THE EYES.
RISK GROUP 2 IEC 62471:2006

VORSICHT
Dieses Produkt strahlt eventuell gefährliche optische Strahlung aus.
Schauen Sie nicht in die eingeschaltete Lampe.
Dies kann Ihre Augen gefährden.
RISIKOGRIFFE 2 IEC 62471:2006

注意
本产品可能会发出有害的光辐射。
请勿直视操作灯。
否则可能有损眼睛。
风险等级 2 IEC 62471:2006

주의
이 제품에서 인체에 유해한 광학
방사선이 발생될 수 있습니다。
작동 환경에서 광학 방사선을 보지 마십시오.
눈에 해로울 수 있습니다。
위험등급 2 IEC 62471:2006

警告 24L80721
強光が製品から放射されます。
投射光を振らないでください。
目に害があることがあります。
リスクグループ2 IEC 62471:2006
Important Information

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and employing compression or expansion of the screen image with the following functions may raise concern about the infringement of copyrights which are protected by copyright law. [ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yönetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.
Power management function
The projector has power management functions. To reduce power consumption, the power management functions (1 and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable connection, use the on-screen menu to change the settings for 1 and 2.

1. STANDBY MODE (Factory preset: NORMAL)
   To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

   **NOTE:**
   • When [NORMAL] is selected for [STANDBY MODE], the following terminals and functions will not work:
     MONITOR OUT (COMP.) terminal, AUDIO OUT terminal, LAN functions, Mail Alert function, DDC/CI (Virtual Remote Tool). Please refer to page 60 about details.
   • When [NETWORK STANDBY] has been set for [STANDBY MODE] and the LAN has been in link-down condition for 3 minutes, [STANDBY MODE] will transit into [NORMAL] automatically for the purpose to save the consumption power.

2. AUTO POWER OFF (Factory preset: 1 hour)
   To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

   **NOTE:**
   • When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is no signal received by any input or if no operation is performed.

---

Health precautions to users viewing 3D images

Before viewing, be sure to read health care precautions that may be found in the user's manual included with your LCD shutter eyeglasses or your 3D compatible content such as DVDs, video games, computer’s video files and the like. To avoid any adverse symptoms, heed the following:

• Do not use LCD shutter eyeglasses for viewing any material other than 3D images.
• Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a distance can strain your eyes.
• Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour of viewing.
• If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D images.
• While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor.
• View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain.

Model Number of Wireless LAN unit

Wireless LAN unit is an optional item. To find the appropriate model to your area, please visit the company website:
URL: http://www.nec-display.com/global/support/index.html
# Table of Contents

## Important Information

1. Introduction ......................................................................................................................... 1

   1 What's in the Box? ............................................................................................................... 1
   2 Introduction to the Projector .......................................................................................... 2
      General ........................................................................................................................... 2
      Light source · Brightness .............................................................................................. 2
      Installation .................................................................................................................... 2
      Videos ............................................................................................................................ 2
      Network ........................................................................................................................ 2
      Energy-saving ............................................................................................................... 3
      About this user's manual ............................................................................................. 3

   3 Part Names of the Projector ........................................................................................... 4
      Front ............................................................................................................................... 4
      Mounting the lens cap strap ...................................................................................... 4
      Rear ............................................................................................................................... 5
      Controls/Indicators ...................................................................................................... 6
      Terminal Panel Features ............................................................................................. 7

   4 Part Names of the Remote Control ................................................................................ 8
      Battery Installation ....................................................................................................... 8
      Remote Control Precautions ..................................................................................... 9
      Operating Range for Wireless Remote Control .......................................................... 9

## 2. Projecting an Image (Basic Operation) ........................................................................ 10

   1 Flow of Projecting an Image .......................................................................................... 10
   2 Connecting Your Computer/Connecting the Power Cord ......................................... 11
   3 Turning on the Projector .............................................................................................. 12
      Note on Startup screen (Menu Language Select screen) ............................................. 13
   4 Selecting a Source ....................................................................................................... 14
      Selecting the computer or video source ................................................................ 14
   5 Adjusting the Picture Size and Position ...................................................................... 16
      Adjusting the vertical position of a projected image (Lens shift) .............................. 17
      Focus ........................................................................................................................... 19
      Zoom ............................................................................................................................ 19
      Adjusting the tilt (Tilt foot) ..................................................................................... 20
   6 Correcting Keystone Distortion [KEYSTONE] ............................................................ 21
   7 Optimizing Computer Signal Automatically ............................................................. 23
      Adjusting the Image Using Auto Adjust .................................................................. 23
   8 Turning Up or Down Volume ....................................................................................... 23
   9 Turning off the Projector ............................................................................................. 24
  10 When Moving the Projector ......................................................................................... 25

## 3. Convenient Features ..................................................................................................... 26

   1 Turning off the Image and Sound .................................................................................. 26
   2 Freezing a Picture ......................................................................................................... 26
   3 Magnifying a Picture ...................................................................................................... 27
   4 Changing Eco Mode/Checking Energy-Saving Effect .................................................. 28
      Using Eco Mode [ECO MODE] .................................................................................. 28
# 4. Using On-Screen Menu

## 1. Using the Menus

### Menu Elements

## 2. List of Menu Items

### Menu Descriptions & Functions [SOURCE]

- HDMI1 and HDMI2...
- COMPUTER
- VIDEO...
- HDBaseT
- APPS

## 3. Menu Descriptions & Functions [ADJUST]

- [PICTURE]...
- [IMAGE OPTIONS]...

## 4. Menu Descriptions & Functions [SETUP]

- [GENERAL]...
- [MENU]...
- [INSTALLATION]...
- [OPTIONS(1)]...
- [OPTIONS(2)]...
- [3D]...

## 5. Menu Descriptions & Functions [INFO.]

- [USAGE TIME]...
- [SOURCE(1)]...
- [SOURCE(2)]...
- [HDBaseT]
- [WIRED LAN]
- [WIRELESS LAN]
- [VERSION(1)]...
- [VERSION(2)]...
- [OTHERS]...

## 7. Menu Descriptions & Functions [RESET]

- Returning to Factory Default [RESET]...

---

# 5. Installation and Connections

## 1. Setting Up the Screen and the Projector

- Tables of screen sizes and dimensions...
- Example of installation on a desktop...
- Lens shifting range...

## 2. Making Connections

- Connecting Your Computer...
- Connecting an External Monitor...
- Connecting Your DVD Player or Other AV Equipment...
- Connecting Component Input...
Connecting HDMI Input............................................................................................................ 78
Connecting your document camera ....................................................................................... 79
Connecting to a Wired LAN .................................................................................................. 80
Connecting to a Wireless LAN (Optional: NP05LM series) ............................................... 81
Connecting to a HDBaseT transmission device (sold commercially) ................................. 84
Portrait projection (vertical orientation) ........................................................................... 86

6. APPS MENU ......................................................................................................................... 88
   ❶ What can you do with the APPS MENU? ................................................................. 88

7. User Supportware ................................................................................................................... 92
   ❶ Software Included on CD-ROM .................................................................................. 92
   ❷ Projecting Your Computer's Screen Image from the Projector over a LAN (Image
       Express Utility Lite) ................................................................................................. 93
       Starting Image Express Utility Lite from a USB Memory or SD Card ............... 96
   ❸ Projecting an Image from an Angle (Geometric Correction Tool in Image Express
       Utility Lite) .................................................................................................................. 98
       What you can do with GCT .................................................................................... 98
       Projecting an Image from an Angle (GCT) ........................................................... 98
   ❹ Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5) ................. 101
   ❺ Using the Computer Cable (VGA) to Operate the Projector (Virtual Remote Tool) .... 106
   ❻ Introduction of MultiPresenter application ............................................................... 112

8. Maintenance .......................................................................................................................... 113
   ❶ Cleaning the Lens ......................................................................................................... 113
   ❷ Cleaning the Cabinet .................................................................................................... 114

9. Appendix ................................................................................................................................ 115
   ❶ Troubleshooting .......................................................................................................... 115
       Indicator Messages .................................................................................................. 115
       Common Problems & Solutions ........................................................................... 117
       If there is no picture, or the picture is not displayed correctly .......................... 118
   ❷ Specifications .............................................................................................................. 119
   ❸ Cabinet Dimensions .................................................................................................... 121
   ❹ Attaching the Optional Cable Cover (NP08CV) ............................................................ 122
       Attaching the cable cover ...................................................................................... 122
       Removing the cable cover ..................................................................................... 123
   ❼ Pin assignments and signal names of main terminals ................................................. 124
   ❽ Compatible Input Signal List ....................................................................................... 126
   ❾ PC Control Codes and Cable Connection .................................................................. 127
   ❿ Update the Software .................................................................................................... 128
   ⓫ Troubleshooting Check List .......................................................................................... 130
   ⓬ TCO Certification ......................................................................................................... 132
   ⓭ REGISTER YOUR PROJECTOR! (for residents in the United States, Canada, and
       Mexico) ......................................................................................................................... 133
1. Introduction

What’s in the Box?

Make sure your box contains everything listed. If any pieces are missing, contact your dealer. Please save the original box and packing materials if you ever need to ship your projector.

- Projector
- Remote control (7N901121)
- Batteries (AAA x 2)
- Power cord (US: 7N080240/7N080243) (EU: 7N080027/7N080029)
- Computer cable (VGA) (7N520089)
- Lens cap strap

• Important Information (7N8N7851)
• Quick Setup Guide (For North America: 7N8N7861) (For Other countries than North America: 7N8N7861 and 7N8N7961)

NEC Projector CD-ROM
User’s manual (PDF) and the utility software (7N952561)

For North America only
Limited warranty
For customers in Europe:
You will find our current valid Guarantee Policy on our Web Site:
www.nec-display-solutions.com
1. Introduction

Introduction to the Projector

This section introduces you to your new projector and describes the features and controls.

General

• Single-chip DLP projector with high resolution and high brightness

<table>
<thead>
<tr>
<th>Model name</th>
<th>DMD panel</th>
<th>Resolution</th>
<th>Aspect ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>P502HL-2</td>
<td>0.65 type</td>
<td>1920 x 1080 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>P502WL-2</td>
<td>0.65 type</td>
<td>1280 x 800 pixels</td>
<td>16:10</td>
</tr>
</tbody>
</table>

Light source - Brightness

• A long-life laser diode is equipped in the light module
  The product can be operated at low cost because the laser light source can be used for a long time without requiring replacement or maintenance.

• Brightness can be adjusted within a wide range
  Unlike with ordinary light sources, the brightness can be adjusted from 16 to 100% in 1% increments.

• [CONSTANT BRIGHTNESS] mode
  Brightness normally decreases with use, but by selecting [CONSTANT BRIGHTNESS] mode, the projector automatically controls the output from the light module according to the light module used time for maintaining constant brightness.

Installation

• Tilt-free, portrait projection
  This projector can be set to any angle within a vertical 360° range. It can also rotate the picture 90° into portrait orientation. This projector cannot be installed with right or left slant besides the portrait projection.

• Lens shift mechanism for adjusting the position of the projected image easily
  The position of the projected image is moved by turning the two dials on the projector cabinet top, one for the vertical direction and another for the horizontal direction.

Videos

• Wide range of input terminals (HDMI × 2, HDBaseT, etc.)
  The projector is equipped with a variety of input terminals: HDMI (× 2), Computer (analog), Video, HDBaseT, etc. HDMI input terminal on this product supports HDCP. HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance.

• Supports HDMI 3D format
  This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear and 3D emitters that support Xpand 3D.

Network

• Equips the feature of APPS MENU that can utilize the network.
  The APPS MENU provides various functions as VIEWER, REMOTE DESKTOP CONNECTION, MultiPresenter, Miracast, NETWORK SETTINGS (Wired LAN/Wireless LAN), and PROGRAM TIMER.

• Convenient utility software (User Supportware) provided as standard
  The five utility software stored in the enclosed NEC Projector CD-ROM (Image Express Utility Lite (For Windows/OS X), Virtual Remote Tool, PC Control Utility Pro 4 (for Windows) and PC Control Utility Pro 5 (for OS X)) can be used.

• CRESTRON ROOMVIEW compatible
  This projector supports CRESTRON ROOMVIEW, allowing multiple devices connected to the network to be managed from a computer or controller.
1. Introduction

- Compatible with the MultiPresenter application
  This projector is compatible with the NEC MultiPresenter application, so multi-screen projection is possible via the network (wired LAN/wireless LAN).

Energy-saving

- 0.15 W (100-130 V AC)/0.36 W (200-240 V AC) in standby condition with energy saving technology
  Selecting [NORMAL] for [STANDBY MODE] from the menu can put the projector in power-saving mode.
  NORMAL: 0.15 W (100-130 V AC)/0.36 W (200-240 V AC)
  NETWORK STANDBY: 2.1 W (100-130 V AC)/2.3 W (200-240 V AC)

- “ECO MODE” for low power consumption and “CARBON METER” display
  The projector is equipped with a “LIGHT MODE” for reducing power consumption during use. Furthermore, the power-saving effect when the [ECO MODE] is set is converted into the amount of reductions of CO₂ emissions and this is indicated on the confirmation message displayed when the power is turned off and at [INFO.] on the on-screen menu (CARBON METER).

About this user's manual

The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to review the user's manual. This may save you time later on. At the beginning of each section of the manual you’ll find an overview. If the section doesn’t apply, you can skip it.
Mounting the lens cap strap
1. Insert the tip of the strap into the lens cap mount hole and pass the knot through.

2. Insert the knot into the strap mount hole (large) on the bottom of the projector, then press it into the narrow (small) hole.
Connect the supplied power cord’s three-pin plug here, and plug the other end into an active wall outlet. (→ page 11)

Wireless LAN cover (→ page 81)

Remote Sensor (→ page 9)

Connection for cable cover (Left/Right) Screw holes (→ page 122)

AC Input

Controls (→ page 6)

Exhaust Vent

Built-in Security Slot (مخاطر) *

Security chain opening
Attach an anti-theft device. The security chain opening accepts security wires or chains up to 0.18 inch/4.6 mm in diameter.

* This security slot supports the MicroSaver® Security System.
1. **POWER** Button  
   (→ page 12, 24)

2. **POWER** Indicator  
   (→ page 11, 12, 24, 115)

3. **STATUS** Indicator  
   (→ page 115)

4. **LIGHT** Indicator  
   (→ page 115)

5. **ECO** Button  
   (→ page 28)

6. **SOURCE** Button  
   (→ page 14)

7. **AUTO ADJ.** Button  
   (→ page 23)

8. **MENU** Button  
   (→ page 37)

9. ▲▼◄► / **Volume** Buttons ◄► / **Keystone** Buttons  
   (→ page 13, 21, 23, 37)

10. **ENTER** Button  
    (→ page 37)

11. **EXIT** Button  
    (→ page 37)
1. COMPUTER IN/ Component Input Terminal (Mini D-Sub 15 Pin)  
(→ page 73, 77, 79)
2. COMPUTER AUDIO IN Mini Jack (Stereo Mini)  
(→ page 73, 77)
3. HDMI 1 IN Terminal (Type A)  
(→ page 73, 74, 78)
4. HDMI 2 IN Terminal (Type A)  
(→ page 73, 74, 78)
5. MONITOR OUT (COMP.) Terminal (Mini D-Sub 15 Pin)  
(→ page 75)
6. AUDIO OUT Mini Jack (Stereo Mini)  
(→ page 75)
7. VIDEO IN Terminal (RCA)  
(→ page 76, 79)
8. VIDEO/S-VIDEO AUDIO IN L/MONO, R (RCA)  
(→ page 76)
9. Ethernet/HDBaseT Port (RJ-45)  
(→ page 80, 84)
10. LAN Port (RJ-45)  
(→ page 80, 85)
11. USB (Wireless LAN) Port  
(→ page 83)
12. USB Port (Type A)  
(→ page 89)
13. 3D SYNC Terminal (Mini DIN 3 Pin)  
(→ page 35)
14. PC CONTROL [PC CONTROL] Port (D-Sub 9 Pin)  
(→ page 127)  
Use this port to connect a PC or control system. This enables you to control the projector using serial communication protocol. If you are writing your own program, typical PC control codes are on page 127.
15. SERVICE Port (USB Type B)  
(for service purpose only)
### Part Names of the Remote Control

1. **Infrared Transmitter**  
   (→ page 9)

2. **POWER ON Button**  
   (→ page 12)

3. **POWER STANDBY Button**  
   (→ page 24)

4. **SOURCE Button**  
   (→ page 14)

5. **COMPUTER 1 Button**  
   (→ page 14)

6. **COMPUTER 2 Button**  
   (This button does not work in this series of projectors)

7. **AUTO ADJ. Button**  
   (→ page 23)

8. **HDMI 1 Button**  
   (→ page 14)

9. **HDMI 2 Button**  
   (→ page 14)

10. **DisplayPort Button**  
    (This button does not work in this series of projectors)

11. **VIDEO Button**  
    (→ page 14)

12. **HDBaseT Button**  
    (→ page 14)

13. **USB-B Button**  
    (This button does not work in this series of projectors)

14. **APPS Button**  
    (→ page 14, 88)

15. **ID SET Button**  
    (→ page 56)

16. **Numeric Keypad Button/ CLEAR Button**  
    (→ page 56)

17. **FREEZE Button**  
    (→ page 26)

18. **AV-MUTE Button**  
    (→ page 26)

19. **MENU Button**  
    (→ page 37)

20. **EXIT Button**  
    (→ page 37)

21. **▲▼◀▶ Button**  
    (→ page 37)

22. **ENTER Button**  
    (→ page 37)

23. **D-ZOOM (+)(–) Button**  
    (→ page 27)

24. **MOUSE L-CLICK Button**  
    (This button does not work in this series of projectors)

25. **MOUSE R-CLICK Button**  
    (This button does not work in this series of projectors)

26. **PAGE ▽△ Button**  
    (→ page 89)

27. **ECO Button**  
    (→ page 28)

28. **KEYSTONE Button**  
    (→ page 21)

29. **PICTURE Button**  
    (→ page 43, 45)

30. **VOL. (+)(–) Button**  
    (→ page 23)

31. **ASPECT Button**  
    (→ page 48)

32. **FOCUS/ZOOM Button**  
    (This button does not work in this series of projectors)

33. **HELP Button**  
    (→ page 65)

* The MOUSE L-CLICK and MOUSE R-CLICK buttons work only when a USB cable is connected with your computer.
1. Introduction

Battery Installation
1. Press firmly and slide the battery cover off.
2. Install new batteries (AAA). Ensure that you have the batteries’ polarity (+/−) aligned correctly.
3. Slip the cover back over the batteries until it snaps into place. Do not mix different types of batteries or new and old batteries.

Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• Do not short, heat, or take apart batteries.
• Do not throw batteries into fire.
• If you will not be using the remote control for a long time, remove the batteries.
• Ensure that you have the batteries’ polarity (+/−) aligned correctly.
• Do not use new and old batteries together, or use different types of batteries together.
• Dispose of used batteries according to your local regulations.
• The remote control sensor on the back of the projector cannot be used when the separately sold cable cover is mounted on the projector.

Operating Range for Wireless Remote Control

• The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of the remote sensor on the projector cabinet.
• The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.
2. Projecting an Image (Basic Operation)

This section describes how to turn on the projector and to project a picture onto the screen.

1 Flow of Projecting an Image

Step 1
• Connecting your computer / Connecting the power cord (→ page 11)

Step 2
• Turning on the projector (→ page 12)

Step 3
• Selecting a source (→ page 14)

Step 4
• Adjusting the picture size and position (→ page 16)
• Correcting keystone distortion [KEYSTONE] (→ page 21)

Step 5
• Adjusting a picture and sound
  - Optimizing a computer signal automatically (→ page 23)
  - Turning up or down volume (→ page 23)

Step 6
• Making a presentation

Step 7
• Turning off the projector (→ page 24)

Step 8
• When Moving the Projector (→ page 25)
2. Projecting an Image (Basic Operation)

2 Connecting Your Computer/Connecting the Power Cord

1. Connect your computer to the projector.
   This section will show you a basic connection to a computer. For information about other connections, see “5. Installation and Connections” on page 73.

   Connect the computer cable (VGA) between the projector’s COMPUTER IN terminal and the computer’s port (mini D-Sub 15 Pin). Turn two thumb screws of both terminals to fix the computer cable (VGA).

2. Connect the supplied power cord to the projector.
   First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other plug of the supplied power cord in the wall outlet.
   The projector’s power indicator will flash for a few seconds and then will light red* (standby mode).
   * This will apply for both indicators when [NORMAL] is selected for [STANDBY MODE]. See the Power Indicator section. (→ page 115)

   CAUTION:
   Parts of the projector may become temporarily heated if the projector is turned off with the POWER button. Be careful to handle the projector.
2. Projecting an Image (Basic Operation)

3 Turning on the Projector

⚠️ WARNING

The projector produces a strong light. When turning on the power, make sure no one within projection range is looking at the lens.

1. **Remove the lens cap.**

With the lens cap’s stopper pressed up, pull forward and off.

2. **Press the (POWER) button on the projector cabinet or the POWER ON button on the remote control.**

The POWER indicator lights blue and the image is projected on the screen.

TIP:
- When the message “PROJECTOR IS LOCKED! ENTER YOUR PASSWORD.” is displayed, it means that the [SECURITY] feature is turned on. (→ page 38)

After you turn on your projector, ensure that the computer or video source is turned on.

**NOTE:** When no input signal is present, the no-signal guidance is displayed (factory menu setting).

(→ page 115)
Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one of the 30 menu languages.

To select a menu language, follow these steps:

1. Use the ▲, ▼, ◀ or ▶ button to select one of the 30 languages from the menu.

PLEASE SELECT A MENU LANGUAGE.

<table>
<thead>
<tr>
<th>Language</th>
<th>Dansk</th>
<th>Suomi</th>
<th>Deutsch</th>
<th>Português</th>
<th>Norsk</th>
<th>Français</th>
<th>Česká</th>
<th>Turek</th>
<th>Español</th>
<th>Polski</th>
<th>Hrvatski</th>
<th>Svenska</th>
<th>Nederlands</th>
<th>Indonesia</th>
<th>Русский</th>
<th>Български</th>
<th>Элхнэка</th>
<th>한국어</th>
<th>日本語</th>
</tr>
</thead>
</table>

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu operation.
If you want, you can select the menu language later.
(→ [LANGUAGE] on page 39 and 52)

NOTE:
• If one of the following things happens, the projector will not turn on.
  - If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool down.
  - If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. Cancel the lock by turning it off. (→ page 54)
• While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
Selecting a Source

Selecting the computer or video source

**NOTE:** Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically

Press the SOURCE button once. The projector will search for the available input source and display it. The input source will change as follows:

[HDMI1] → [HDMI2] → [COMPUTER] → [VIDEO] → [HDBaseT] → [APPS]

- With the SOURCE screen displayed, you can press the SOURCE button a few times to select the input source.

![Image of SOURCE buttons](image)

**TIP:** If no input signal is present, the input will be skipped.

Using the Remote Control

Press any one of the COMPUTER 1, HDMI1, HDMI2, VIDEO, HDBaseT, or APPS buttons.
2. Projecting an Image (Basic Operation)

Selecting Default Source
You can so that it will be displayed each time the projector is turned on.

1. **Press the MENU button.**
   The menu will be displayed.

2. **Press the ▶ button twice to select [SETUP] and the ▼ button or the ENTER button to select [GENERAL].**

3. **Press the ▶ button four times to select [OPTIONS(2)].**

4. **Press the ▼ button five times to select [DEFAULT SOURCE SELECT] and press the ENTER button.**

The [DEFAULT SOURCE SELECT] screen will be displayed.  
(→ page 62)

5. **Select a source as the default source, and press the ENTER button.**

6. **Press the EXIT button a few times to close the menu.**

7. **Restart the projector.**
   The source you selected in step 5 will be projected.

**TIP:**
- When the projector and computer are connected and the projector is in standby, it is possible to turn on the projector’s power and project the computer’s screen automatically by detecting the computer signals or HDMI signals issued from the computer.  
  ([AUTO POWER ON] → page 61)
- On Windows 7, a combination of the Windows and P keys allows you to set up external display easily and quickly.
## Adjusting the Picture Size and Position

Use the lens shift dial, the adjustable tilt foot lever, the zoom lever/zoom ring and the focus ring to adjust the picture size and position. *In this chapter drawings and cables are omitted for clarity.*

<table>
<thead>
<tr>
<th>Adjusting the projected image’s vertical and horizontal position [Lens shift] (→ page 17)</th>
<th>Adjusting the focus [Focus ring] (→ page 19)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Finely adjusting the size of an image [Zoom lever] (→ page 19)</th>
<th>Adjusting the projected image’s height and horizontal tilt [Tilt foot] (→ page 20)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Correcting the keystone distortion [Keystone]* (→ page 21)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Image" /></td>
</tr>
</tbody>
</table>

* To perform keystone correction manually, see “6. Correcting Keystone Distortion [KEYSTONE]” on page 21.
Adjusting the vertical position of a projected image (Lens shift)

**CAUTION**
Perform the adjustment from behind or from the side of the projector. Adjusting from the front could expose your eyes to strong light which could injure them.

1. **Open the lens shift cover.**
   - Open with the cover’s stopper pushed forward.
   - The lens shift cover cannot be removed.

2. **Turn the lens shift dials clockwise or counterclockwise.**
   - **Vertical dial**
     Turn this clockwise or counterclockwise to adjust the projection position in the vertical direction.
   - **Horizontal dial**
     Turn this clockwise or counterclockwise to adjust the projection position in the horizontal direction.

**NOTE:**
- The dials can be turned more than one full turn, but the projection position cannot be moved more than the range indicated on the following page. Do not force to turn the dials. Doing so may damage the dials.
- If the lens is shifted to the maximum in the diagonal direction, the edges of the screen will be dark or shaded.
- The vertical shift adjustment must be finished with an image shifted upward. If you finish the vertical shift adjustment with an image shifted down, the zoom/focus adjustments or strong shaking may cause a projected image to slightly shift down.
3. Close the lens shift cover.

Insert the cover’s 2 (two) hooks into the grooves in the projector, then close the cover.

TIP:
• The diagram below shows the lens shift adjustment range ([ORIENTATION]: [DESKTOP FRONT]).
• For the lens shift adjustment range regarding the [CEILING FRONT] projection, see page 71.

[P502HL-2]

Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the projected image).
Focus
Use the FOCUS ring to obtain the best focus.
• Recommend to perform the focus adjustment after leaving the projector under the state the TEST PATTERN has been projected for over 30 minutes.
  Please refer to page 57 about the TEST PATTERN.

Zoom
Turn the zoom lever clockwise and counterclockwise.
2. Projecting an Image (Basic Operation)

Adjusting the tilt (Tilt foot)

Adjusting the left and right tilt.

1. **Turn the left and right tilt feet to adjust.**

   The tilt feet lengthen and shorten when turned. The height of the projected image is adjusted by turning the left and right tilt feet.

   If the projected image is tilted, turn one of the tilt feet to adjust the image so that it is level.

   • If the projected image is distorted, see “6 Correcting Keystone Distortion [KEYSTONE]” (→ page 21).
   • The tilt feet can be lengthened by a maximum of 20 mm.
   • The tilt feet can be used to tilt the projector by a maximum of 4°.

**NOTE:**

• Do not lengthen the tilt feet any more than 20 mm/0.8”. Doing so will make the tilt feet’s mount section unstable and could cause the tilt feet to come off the projector.

• Do not use the tilt feet for any purpose other than adjusting the projector’s projection angle. Handling the tilt feet improperly, such as carrying the projector by grasping the tilt feet or hooking it onto a wall using the tilt feet, could damage the projector.
6 Correcting Keystone Distortion [KEYSTONE]

When the projector is not exactly perpendicular to the screen, keystone distortion occurs. To overcome it, you can use the “Keystone” function, a digital technology that can adjust for keystone-type distortion, resulting in a crisp, square image. The following procedure explains how to use the [KEYSTONE] screen from the menu to correct trapezoidal distortions. When the projector is placed diagonally to the screen, When the projector is set up at an angle in relation to the screen, adjust the Horizontal option of the Keystone menu so that the top and bottom of sides of the projected image are parallel.

1. When APPS is not selected as source and the menu is not displayed on, press the ▼ button on the projector cabinet. The Keystone screen will be displayed on the screen.
   • Press the KEYSTONE button when using the remote control.
   • See page 22 for [RESET].

2. Press the ▼ button to select [VERTICAL] and then use the ◀ or ▶ so that the left and right sides of the projected image are parallel.
   * Adjust the vertical keystone distortion.

3. Align the left (or right) side of the screen with the left (or right) side of the projected image.
   • Use the shorter side of the projected image as the base.
   • In the right example, use the left side as the base.
2. Projecting an Image (Basic Operation)

4. Press the ▲ button to select [HORIZONTAL] and then use the ◄ or ► so that the top and bottom sides of the projected image are parallel.
   • Adjust the horizontal keystone distortion.

5. Repeat steps 2 and 4 to correct keystone distortion.

6. After completing Keystone correction, press the EXIT button.
   The Keystone screen will disappear.
   • To perform Keystone correction again, press the ▼ button to display the Keystone screen and repeat above steps 1 to 6.

To return the keystone adjustments to default:
1. Press the ▼ button to select [RESET] and press the ENTER button.

2. Press the ◄ or ► button to select [YES] and press the ENTER button.

   The adjustments will be reset.
   • When resetting, the [HORIZONTAL] and [VERTICAL] adjustment values are also reset.
   • The KEYSTONE feature can cause an image to be slightly blurred because the correction is made electronically.
7 Optimizing Computer Signal Automatically

Adjusting the Image Using Auto Adjust

Optimizing a computer image automatically. (COMPUTER)
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

![Poor picture]  ![Normal picture]

**NOTE:**
Some signals may take time to display or may not be displayed correctly.
- If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] manually. (→ page 46, 47)

8 Turning Up or Down Volume

Sound level from the speaker or audio output can be adjusted.

**TIP:** When no menus appear, the ◀ and ▶ buttons on the projector cabinet work as a volume control.

**NOTE:**
- Volume control is not available with the ◀ or ▶ button when an image is magnified by using the D-ZOOM (+) button, when the menu is displayed, or when the APPS is displayed.

**TIP:** The [BEEP] sound volume cannot be adjusted. To turn off the [BEEP] sound, from the menu, select [SETUP] → [OPTIONS (1)] → [BEEP] → [OFF].
9 Turning off the Projector

To turn off the projector:

1. **First, press the (POWER) button on the projector cabinet or the STANDBY button on the remote control.**
   
   The confirmation message will be displayed.
   
   - The confirmation message displayed when the power is turned off indicates the amount of CO2 reduction this session (→ page 29).

   ![Power Off Message]

   ![Carbon Savings Session Message]

2. **Secondly, press the ENTER button or press the (POWER) or the STANDBY button again.**
   
   When the light source turns off, the power turns off too. The cooling fan runs for about 10 minutes. When the cooling fan stops to run, the projector will go into the STANDBY mode.

   When in standby mode, the POWER indicator will light red and the STATUS indicator will turn off when [NORMAL] is selected for [STANDBY MODE].

3. **Mount the lens cap.**
   
   Insert the cap’s 2 (two) hooks into the grooves of the projector, then press at the bottom of the lens cap. The stopper is secured to the projector.

   ![Hook and Stopper Diagram]

---

**CAUTION:**
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button. Be careful to handle the projector.

---

**NOTE:**
- Do not unplug the power cord from the projector or from the power outlet while an image is being projected and the cooling fan is rotating. Doing so could deteriorate the projector’s AC IN terminal or the power plug’s contact. Do not shut off the AC power supply while an image is being projected. Do not disconnect the AC power cord until the POWER indicator turns ON in red.
When Moving the Projector

Preparation: Make sure that the projector is turned off.

1. If the separately sold cable cover is mounted, remove it.
   (→ page 122)

2. Unplug the power cord.

3. Disconnect any other cables.
   - Remove the USB memory if it is inserted into the projector.
3. Convenient Features

1 Turning off the Image and Sound
Press the AV-MUTE button to turn off the image and sound for a short period of time. Press again to restore the image and sound.

NOTE:
• Even though the image is turned off, the menu still remains on the screen.

2 Freezing a Picture
Press the FREEZE button. If the image of a DVD player, etc., is being projected, the video switches to a still image. Press the FREEZE button again to resume the video.

NOTE: The image is frozen but the original video is still playing back.
Magnifying a Picture

You can enlarge the picture up to four times.

NOTE:

- The maximum magnification may be less than four times depending on the signal.

To do so:

1. **Press the D-ZOOM (+) button to magnify the picture.**
   To move the magnified image, use the ▲,▼,◀ or ▶ button.

2. **Press the ▲▼◀▶ button.**
   The area of the magnified image will be moved

3. **Press the D-ZOOM (−) button.**
   Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE:

- The image will be magnified or demagnified at the center of the screen.
- Displaying the menu will cancel the current magnification.
### Changing Eco Mode/Checking Energy-Saving Effect

**Using Eco Mode [ECO MODE]**

When the [LIGHT MODE]'s [ECO MODE] is set to [ECO1] or [ECO2], the brightness and the operating sound are reduced. Furthermore, the power consumption is decreased and the projector's CO₂ emissions are reduced.

<table>
<thead>
<tr>
<th>[ECO MODE]</th>
<th>Icon at the bottom of the menu</th>
<th>Description</th>
<th>Status of LIGHT indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>[OFF]</td>
<td></td>
<td>100% brightness The screen will be brightly lit.</td>
<td>Off</td>
</tr>
<tr>
<td>[ECO1]</td>
<td>![Icon]</td>
<td>Brightness will be at about 80%. The cooling fan will also slow down accordingly. Lower power consumption</td>
<td>Steady Green light</td>
</tr>
<tr>
<td>[ECO2]</td>
<td>![Icon]</td>
<td>Brightness will be at about 50%. The cooling fan will also slow down accordingly. Lower power consumption considerably</td>
<td></td>
</tr>
</tbody>
</table>

To turn on the [ECO MODE], do the following:

1. **Press the ECO Button on the remote control to display [ECO MODE] screen.**
2. **Use the ▼▲ buttons to select, then press the ENTER button.**
   - The [ECO MODE] selection screen turns off and the projector switches to the selected mode.
   - When in the [ECO MODE], the LIGHT indicator lights green.

**NOTE:**
- The [ECO MODE] can be changed by using the menu. Select [SETUP] → [GENERAL] → [LIGHT MODE] → [ECO MODE].
- The [LIGHT HOURS USED] can be checked in [USAGE TIME]. Select [INFO.] → [USAGE TIME].
- After a lapse of 1 minute from when the projector displays no-signal guidance, a blue, black or logo screen, the projector goes into [ECO2] automatically. The projector will return to its original setting once a signal is accepted.
- If the projector inside temperature becomes high caused on the high room temperature, the projector may decrease the brightness temporarily for protecting itself. This is a protective function called [FORCED ECO MODE]. When the projector is in the [FORCED ECO MODE], the thermometer symbol (🌡️) is indicated at the right bottom of the screen. When the projector inside temperature goes down by cooling the room or setting the fan mode to [HIGH], the [FORCED ECO MODE] will be released and the projector will be back to the original setting state. During the [FORCED ECO MODE], it disables to change the state by changing the setting of the [ECO MODE].
3. Convenient Features

Checking Energy-Saving Effect [CARBON METER]

This feature will show energy-saving effect in terms of CO₂ emission reduction (kg) when the projector’s [ECO MODE] is set to [ECO1] or [ECO2]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON SAVINGS] message shows the total amount of CO₂ emission reduction from the time of shipment up to now. You can check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 65)

The [CARBON SAVINGS-SESSION] message shows the amount of CO₂ emission reduction between the time of changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:

- The formula as shown below is used to calculate the amount of CO₂ emission reduction.
  
  \[
  \text{Amount of CO}_2\text{ emission reduction} = \left( \text{Power consumption in [OFF] for [ECO MODE]} - \text{Power consumption in [ECO1]/[ECO2] for [ECO MODE]} \right) \times \text{CO}_2\text{ conversion factor}.\]
  
  When the image is turned off with the AV-MUTE button, the amount of CO₂ emission reduction will also increase.

  - Calculation for amount of CO₂ emission reduction is based on an OECD publication “CO₂ Emissions from Fuel Combustion, 2008 Edition”.

- The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.

- This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
3. Convenient Features

5 Preventing the Unauthorized Use of the Projector [SECURITY]

A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the projector cannot project an image.

- The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1. Press the MENU button.
   The menu will be displayed.
2. Press the ▶ button twice to select [SETUP] and press the ▼ button or the ENTER button to select [GENERAL].
3. Press the ▶ button to select [INSTALLATION].
4. Press the ▼ button three times to select [SECURITY] and press the ENTER button.

![Menu Screen]

The OFF/ON menu will be displayed.

5. Press the ▼ button to select [ON] and press the ENTER button.

![Security Setting Screen]

The [SECURITY KEYWORD] screen will be displayed.

6. Type in a combination of the four ▲▼◀▶ buttons and press the ENTER button.

   **NOTE:** A keyword must be 4 to 10 digits in length.

![Keyword Input Screen]

The [CONFIRM KEYWORD] screen will be displayed.
7. Type in the same combination of ▲▼◄► buttons and press the ENTER button.

The confirmation screen will be displayed.

8. Select [YES] and press the ENTER button.

The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1. Press the POWER button.
   The projector will be turned on and display a message to the effect that the projector is locked.

2. Press the MENU button.

3. Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
To disable the SECURITY function:

1. **Press the MENU button.**
   The menu will be displayed.

2. **Select [SETUP] → [INSTALLATION] → [SECURITY] and press the ENTER button.**

   ![Setup Menu]

   The OFF/ON menu will be displayed.

3. **Select [OFF] and press the ENTER button.**

   ![Security OFF/ON]

   The SECURITY KEYWORD screen will be displayed.

4. **Type in your keyword and press the ENTER button.**
   When the correct keyword is entered, the SECURITY function will be disabled.

   **NOTE:** If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request code. Your request code is displayed in the Keyword Confirmation screen. In this example [K992-45L8-JNGJ-4XU9-1YAT-EEA2] is a request code.
 Viewing 3D Images

The projector provides 3D images to a user wearing commercially available LCD shutter eyeglasses.

**CAUTION**

Health precautions
Before viewing, be sure to read health care precautions that may be found in the user’s manual included with your LCD shutter eyeglasses or your 3D compatible content such as DVDs, video games, computer’s video files and the like. To avoid any adverse symptoms, heed the following:

- Do not use LCD shutter eyeglasses for viewing any material other than 3D images.
- Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a distance can strain your eyes.
- Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour of viewing.
- If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D images.
- While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor.
- View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain.

**LCD shutter eyeglasses (recommended)**

- Use commercially available DLP® Link or other method compatible LCD shutter eyeglasses.

**Steps for viewing 3D images on the projector**

1. **Connect the projector to your video equipment.**
2. **Turn on the projector, display the on-screen menu, and then select [ON] for the 3D mode.**
   
   For the operating procedure to turn on the 3D mode, refer to “On-screen menu for 3D images” on the following page.
3. **Play your 3D compatible content and use the projector to display the image.**
4. **Put on your LCD shutter eyeglasses to view 3D images.**
   
   Also refer to the user’s manual accompanied with your LCD shutter eyeglasses for more information.

**On-screen menu for 3D images**

Follow the steps to display the 3D menu.
1. **Press the MENU button.**
   
   The on-screen menu will be displayed.
2. **Press the ▶ button twice.**
   
   The [SETUP] menu will be displayed.
3. **Press the ▼ button once, and then press the ▶ button five times.**
3. Convenient Features

The [3D] menu will be displayed

![Menu Display](image)

4. **Press the ▼ button to select a signal and press the ENTER button.**

   The 3D (DETAIL SETTINGS) screen will be displayed.

![Detail Settings](image)

5. **Press the ▼ button to [GLASSES] and press the ENTER button.**

   The [GLASSES] setting screen will be displayed.

6. **Press the ▼ button to select a compatible eyeglass method and press the ENTER button.**

   Set other 3D-related menu options such as [FORMAT] and [L/R INVERT] as necessary.

   When switched to a 3D image, the 3D viewing cautions message screen appears (by factory default). For details, see page 53.

7. **Press either △ or ▼ button to select [3D] and press the ENTER button.**

   The setting screen for 3D mode will be displayed on.

8. **Press the ▼ button to select [ON] and press the ENTER button.**

   The selected signal will be changed in 3D mode.

Selecting input connected to a source of 3D images [HDMI1/HDMI2/COMPUTER/VIDEO/HDBaseT]

This function switches the 3D mode between ON and OFF for each input.

**NOTE:**

To confirm that the supported 3D signal is accepted, use either way of the following:

- Make sure that [3D] is displayed in the top right of the screen after the source is selected.
- Display [INFO.] → [SOURCE(2)] → [3D SIGNAL] and make sure that “SUPPORTED” is displayed.
3. Convenient Features

To view 3D images, see page 33.
Select [HDMI1], [HDMI2], [COMPUTER], [VIDEO], or [HDBaseT].

NOTE:
- The maximum distance for viewing 3D images is 10 m/394 inches from the screen surface under the following restrictions:
  - Brightness on the projector: 2000 lumens or greater
  - Screen gain: 1
  - Viewing position: Facing straight towards the screen center
  - Outside light: None
  - LCD shutter eyeglasses: DLP® Link compatible 3D eyeglasses
- If 3D content is played back on your computer and the performance is poor it may be caused by the CPU or graphics chip. In this case you may have difficulty seeing the 3D images as they were intended. Check to see if your computer meets the requirements provided in your user’s manual included with your 3D content.
- The DLP® Link compatible LCD shutter eyeglasses allow you to view 3D images by receiving synch signals, which are included in left eye and right eye images, reflected from the screen. Depending on environments or conditions such as the ambient brightness, screen size or viewing distance, the LCD shutter eyeglasses may fail to receive synch signals, causing poor 3D images.
- When the 3D mode is enabled, the Keystone correction range will be narrower.
- When the 3D mode is enabled, the following settings are invalid.
  - [WALL COLOR], [PRESET], [REFERENCE], [COLOR TEMPERATURE]
- Refer to the [SOURCE(2)] screen under the [INFO.] menu for information on whether the input signal is 3D compatible.
- Signals other than those listed in “Compatible Input Signal List” on page 126 will be out of range or will be displayed in 2D.

Using a 3D emitter
This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear. In order to synchronize the 3D video and eyewear, a commercially-available 3D emitter needs to be connected to the projector (on the projector side).
The 3D eyewear receives information from the 3D emitter and performs opening and closing on the left and right.

3D eyewear and 3D emitter preparations
Please use an active shutter-type 3D eyewear that conforms with the VESA standard.
A commercially-available RF type made by Xpand is recommended.
  3D eyewear............ Xpand X105-RF-X2
  3D emitter............. Xpand AD025-RF-X1

Connect your 3D emitter to the 3D SYNC terminal of the projector.

NOTE:
- Use an active shutter 3D eyewear (compliance with VESA)
- Check the operating conditions described in the user manual of the Blu-ray player.
- Please connect the DIN terminal of the 3D emitter to the 3D SYNC of the projector.
- The 3D eyewear allows videos to be viewed in 3D by receiving synchronized optical signals output from the 3D emitter. As a result, the 3D image quality may be affected by conditions such as the brightness of the surroundings, screen size, viewing distance, etc.
- When playing a 3D video software on a computer, the 3D image quality may be affected if the computer CPU and graphics chip performance are low. Please check the required operating environment of the computer that is stated in the operating manual attached to the 3D video software.
## Troubleshooting on viewing 3D images

If images will not be displayed in 3D or 3D images appear as 2D, check the following table. Also refer to the user’s manual accompanied with your 3D content or LCD shutter eyeglasses.

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The content you are playing back is not compatible with 3D.</td>
<td>• Play back a content compatible with 3D.</td>
</tr>
<tr>
<td>• The 3D mode was turned off for the selected source.</td>
<td>• Use the projector’s menu to turn on 3D mode for the selected source.</td>
</tr>
<tr>
<td>• You are not using our recommended LCD shutter eyeglasses.</td>
<td>• Use our recommended LCD shutter eyeglasses. (→ page 33)</td>
</tr>
<tr>
<td>• If the shutter of your LCD shutter eyeglasses cannot synchronize with the currently projected source, the following are possible causes:</td>
<td></td>
</tr>
<tr>
<td>- Your LCD shutter eyeglasses are not switched on.</td>
<td>• Switch on your LCD shutter eyeglasses.</td>
</tr>
<tr>
<td>- The battery in the LCD shutter eyeglasses ran down.</td>
<td>• Recharge the battery or replace it.</td>
</tr>
<tr>
<td>- The correct eyeglass method is not selected.</td>
<td>• Change the eyeglass method for 3D by using the menu. (→ page 63)</td>
</tr>
<tr>
<td>- The viewing distance between the viewer and the screen is too far.</td>
<td>• Move closer to the screen until the viewer gets 3D images.</td>
</tr>
<tr>
<td>- There are bright light sources or other projectors near the viewer.</td>
<td>• Keep light sources or other projectors away from the viewer.</td>
</tr>
<tr>
<td>• If your computer is not set for 3D viewing, the following are possible causes:</td>
<td>• Check to see if your computer meets the requirements provided in your user’s manual included with your 3D content.</td>
</tr>
<tr>
<td>- Your computer does not meet the requirements for 3D viewing.</td>
<td>• Set your computer for 3D output.</td>
</tr>
<tr>
<td>- Your computer is not set for 3D output.</td>
<td></td>
</tr>
<tr>
<td>For using a 3D emitter:</td>
<td></td>
</tr>
<tr>
<td>- There is an obstacle between the optical receiver of the 3D eyewear and the 3D emitter.</td>
<td>• Please remove the obstacle.</td>
</tr>
<tr>
<td>- The 3D format of the 3D video contents is not supported.</td>
<td>• Please check with the company selling the 3D video contents.</td>
</tr>
</tbody>
</table>
4. Using On-Screen Menu

1. **Using the Menus**

   **NOTE:** The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

   1. Press the **MENU** button on the remote control or the projector cabinet to display the menu.

   ![Menu Diplay]

   **NOTE:** The commands such as **ENTER**, **EXIT**, ▲▼, ◀▶ in the bottom show available buttons for your operation.

   2. Press the ◀▶ buttons on the remote control or the projector cabinet to display the submenu.

   3. Press the **ENTER** button on the remote control or the projector cabinet to highlight the top item or the first tab.

   4. Use the ▲▼ buttons on the remote control or the projector cabinet to select the item you want to adjust or set.

   You can use the ◀▶ buttons on the remote control or the projector cabinet to select the tab you want.

   5. Press the **ENTER** button on the remote control or the projector cabinet to display the submenu window.

   6. Adjust the level or turn the selected item on or off by using the ▲▼ ◀▶ buttons on the remote control or the projector cabinet.

   Changes are stored until adjusted again.

   7. Repeat steps 2-6 to adjust an additional item, or press the **EXIT** button on the remote control or the projector cabinet to quit the menu display.

   **NOTE:** When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

   8. Press the **MENU** button to close the menu.

   To return to the previous menu, press the **EXIT** button.
Menu Elements

Menu windows or dialog boxes typically have the following elements:

- **Highlight**: Indicates the selected menu or item.
- **Solid triangle**: Indicates further choices are available. A highlighted triangle indicates the item is active.
- **Tab**: Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
- **Radio button**: Use this round button to select an option in a dialog box.
- **Source**: Indicates the currently selected source.
- **Off Timer remaining time**: Indicates the remaining countdown time when the [OFF TIMER] is preset.
- **Slide bar**: Indicates settings or the direction of adjustment.
- **ECO mode symbol**: Indicates ECO MODE is set.
- **Key Lock symbol**: Indicates the [CONTROL PANEL LOCK] is enabled.
- **Thermometer symbol**: Indicates the projector is in the state of the [FORCED ECO MODE].
- **Wireless symbol**: Indicate the wireless LAN connection is enabled.
- **Menu mode**: Indicate the [ADVANCED] menu or [BASIC] menu.
### List of Menu Items

Some menu items are not available depending on the input source. The below listed menu items are on the advanced menu. The mark (B) is added to the items on the basic menu.

Refer to 88 pages about the APPS MENU.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOURCE</td>
<td>(B) *</td>
</tr>
<tr>
<td>HDMI1</td>
<td>*</td>
</tr>
<tr>
<td>HDMI2</td>
<td>*</td>
</tr>
<tr>
<td>COMPUTER</td>
<td>*</td>
</tr>
<tr>
<td>VIDEO</td>
<td>*</td>
</tr>
<tr>
<td>HDBaseT</td>
<td>*</td>
</tr>
<tr>
<td>APPS</td>
<td>*</td>
</tr>
<tr>
<td>ADJUST</td>
<td>PRESET * 1–8</td>
</tr>
<tr>
<td>DETAIL SETTINGS</td>
<td>REFERENCE *</td>
</tr>
<tr>
<td>GAMMA CORRECTION*1</td>
<td>DYNAMIC, NATURAL, BLACK DETAIL</td>
</tr>
<tr>
<td>SCREEN SIZE*2</td>
<td>LARGE, MEDIUM, SMALL</td>
</tr>
<tr>
<td>COLOR TEMPERATURE</td>
<td>*</td>
</tr>
<tr>
<td>COLOR ENHANCEMENT</td>
<td>*</td>
</tr>
<tr>
<td>DYNAMIC CONTRAST</td>
<td>*</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>(B) 63</td>
</tr>
<tr>
<td>BRIGHTNESS</td>
<td>(B) 63</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>(B) 7</td>
</tr>
<tr>
<td>COLOR</td>
<td>(B) 31</td>
</tr>
<tr>
<td>HUE</td>
<td>(B) 31</td>
</tr>
<tr>
<td>RESET</td>
<td>(B)</td>
</tr>
<tr>
<td>IMAGE OPTIONS</td>
<td>CLOCK *</td>
</tr>
<tr>
<td>PHASE</td>
<td>*</td>
</tr>
<tr>
<td>HORIZONTAL</td>
<td>*</td>
</tr>
<tr>
<td>VERTICAL</td>
<td>*</td>
</tr>
<tr>
<td>OVERSCAN</td>
<td>AUTO AUTO, 0(%), 5(%), 10(%)</td>
</tr>
<tr>
<td>ASPECT RATIO</td>
<td>AUTO, 4:3, 16:9, T5:9, 16:10, LETTERBOX, NATIVE</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF</td>
</tr>
<tr>
<td>SETUP</td>
<td>GENERAL</td>
</tr>
<tr>
<td>KEYSTONE</td>
<td>(B)</td>
</tr>
<tr>
<td>HORIZONTAL</td>
<td>0</td>
</tr>
<tr>
<td>VERTICAL</td>
<td>0</td>
</tr>
<tr>
<td>RESET</td>
<td></td>
</tr>
<tr>
<td>WALL COLOR</td>
<td>(B)</td>
</tr>
<tr>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>ECO MODE</td>
<td>OFF</td>
</tr>
<tr>
<td>ADJUST</td>
<td>100</td>
</tr>
<tr>
<td>CONSTANT BRIGHTNESS</td>
<td>OFF</td>
</tr>
<tr>
<td>CLOSED CAPTION</td>
<td>OFF</td>
</tr>
<tr>
<td>LIGHT MODE</td>
<td>LIGHT MODE</td>
</tr>
<tr>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>ECO MODE</td>
<td>OFF</td>
</tr>
<tr>
<td>ADJUST</td>
<td>100</td>
</tr>
<tr>
<td>CONSTANT BRIGHTNESS</td>
<td>OFF</td>
</tr>
<tr>
<td>CLOSED CAPTION</td>
<td>OFF</td>
</tr>
<tr>
<td>OFF TIMER</td>
<td>(B)</td>
</tr>
<tr>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>TOOLS</td>
<td>(B)</td>
</tr>
<tr>
<td>TO APPS MENU</td>
<td></td>
</tr>
<tr>
<td>LANGUAGE</td>
<td>(B)</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, SVENSKA, 日本語, DANSK, PORTUGUES, CEŞTINA, MAGYAR, POLSKI, NEDERLANDS, SUOMI, NORSK, TÜRKÇE, РУССКИЙ, ΕΛΛΗΝΙΚΑ, 한국어, Tiếng Việt, ROMANA, Hrvatski, БЪЛГАРСКИ, INDONESIA, తెలుగు, 繁體中文</td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.

*1 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].

*2 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
### 4. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SETUP</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COLOR SELECT</td>
<td>COLOR</td>
<td>COLOR, MONOCHROME</td>
</tr>
<tr>
<td>SOURCE DISPLAY</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>ID DISPLAY</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>DISPLAY TIME</td>
<td>AUTO 15 SEC</td>
<td>MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC</td>
</tr>
<tr>
<td>BACKGROUND</td>
<td>BLUE</td>
<td>BLUE, BLACK, LOGO</td>
</tr>
<tr>
<td>3D CAUTION MESSAGE</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>INSTALLATION</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORIENTATION</td>
<td>AUTO</td>
<td>AUTO, DESKTOP FRONT, CEILING REAR, DESKTOP REAR, CEILING FRONT</td>
</tr>
<tr>
<td>CONTROL PANEL LOCK</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>SECURITY</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>COMMUNICATION SPEED</td>
<td>38400bps</td>
<td>4800bps, 9600bps, 19200bps, 38400bps</td>
</tr>
<tr>
<td>SERIAL PORT</td>
<td>PC CONTROL</td>
<td>PC CONTROL, HDBaseT</td>
</tr>
<tr>
<td>REMOTE SENSOR</td>
<td>ALL</td>
<td>ALL, FRONT/BACK, FRONT, BACK, HDBaseT</td>
</tr>
<tr>
<td>CONTROL ID</td>
<td>CONTROL ID NUMBER 1</td>
<td>1, 1–254</td>
</tr>
<tr>
<td></td>
<td>CONTROL ID OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>OPTIONS(1)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAN MODE</td>
<td>AUTO</td>
<td>AUTO, HIGH</td>
</tr>
<tr>
<td>WXGA MODE</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>IMAGE MODE</td>
<td>AUTO</td>
<td>AUTO, STILL, MOVIE</td>
</tr>
<tr>
<td><strong>HDMI SETTINGS</strong></td>
<td>HDMI1 VIDEO LEVEL</td>
<td>AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td><strong>HDMI2 VIDEO LEVEL</strong></td>
<td>AUTO</td>
<td>AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td><strong>HDBaseT VIDEO LEVEL</strong></td>
<td>AUTO</td>
<td>AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td>AUDIO SELECT</td>
<td>HDMI1</td>
<td>HDMI1, COMPUTER</td>
</tr>
<tr>
<td></td>
<td>HDMI2</td>
<td>HDMI2, COMPUTER</td>
</tr>
<tr>
<td></td>
<td>HDBaseT</td>
<td>HDBaseT, COMPUTER</td>
</tr>
<tr>
<td>BEEP</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>OPTIONS(2)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STANDBY MODE</td>
<td>NORMAL</td>
<td>NORMAL, NETWORK STANDBY</td>
</tr>
<tr>
<td>DIRECT POWER ON</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>AUTO POWER OFF</td>
<td>1:00</td>
<td>OFF, 0:05, 0:10, 0:20, 0:30, 1:00</td>
</tr>
<tr>
<td>DEFAULT SOURCE SELECT</td>
<td>LAST</td>
<td>LAST, AUTO, HDMI1, HDMI2, COMPUTER, VIDEO, HDBaseT, APPS</td>
</tr>
<tr>
<td><strong>3D</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDMI1 3D 3D</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>GLASSES</td>
<td>DLP® Link</td>
<td>DLP® Link, OTHERS</td>
</tr>
<tr>
<td>FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>HDMI2 3D 3D</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>GLASSES</td>
<td>DLP® Link</td>
<td>DLP® Link, OTHERS</td>
</tr>
<tr>
<td>FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>COMPUTER 3D 3D</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>GLASSES</td>
<td>DLP® Link</td>
<td>DLP® Link, OTHERS</td>
</tr>
<tr>
<td>FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>VIDEO 3D 3D</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>HDBaseT 3D 3D</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>GLASSES</td>
<td>DLP® Link</td>
<td>DLP® Link, OTHERS</td>
</tr>
<tr>
<td>FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.
### Menu Item

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INFO</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USAGE TIME</td>
<td>LIGHT HOURS USED</td>
<td></td>
</tr>
<tr>
<td>TOTAL CARBON SAVINGS</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SOURCE(1)</strong></td>
<td>RESOLUTION</td>
<td></td>
</tr>
<tr>
<td>HORIZONTAL FREQUENCY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VERTICAL FREQUENCY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYNC TYPE</td>
<td>SEPARATE SYNC, COMPOSITE SYNC, SYNC ON GREEN, SYNC ON VIDEO</td>
<td></td>
</tr>
<tr>
<td>SYNC POLARITY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCAN TYPE</td>
<td>INTERLACE, NON-INTERLACE</td>
<td></td>
</tr>
<tr>
<td><strong>SOURCE(2)</strong></td>
<td>SIGNAL TYPE</td>
<td></td>
</tr>
<tr>
<td>VIDEO TYPE</td>
<td>RGB, VIDEO, YCbCr</td>
<td></td>
</tr>
<tr>
<td>BIT DEPTH</td>
<td>8[bits], 10[bits], 12[bits]</td>
<td></td>
</tr>
<tr>
<td>VIDEO LEVEL</td>
<td>FULL, ENHANCED, DEFAULT</td>
<td></td>
</tr>
<tr>
<td>3D SIGNAL</td>
<td>SUPPORTED, NOT SUPPORTED</td>
<td></td>
</tr>
<tr>
<td><strong>HDBaseT</strong></td>
<td>SIGNAL QUALITY</td>
<td>NORMAL, WARNING, ABNORMAL</td>
</tr>
<tr>
<td>OPERATION MODE</td>
<td>HDBaseT, ETHERNET, LOW POWER, DISCONNECT</td>
<td></td>
</tr>
<tr>
<td>LINK STATUS</td>
<td>NO LINK, HDBaseT, LOW POWER, ETHERNET</td>
<td></td>
</tr>
<tr>
<td>HDMI STATUS</td>
<td>NO HDMI, HDMI ON, HDCP ON</td>
<td></td>
</tr>
<tr>
<td><strong>WIRED LAN</strong></td>
<td>IP ADDRESS</td>
<td></td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GATEWAY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAC ADDRESS</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WIRELESS LAN</strong></td>
<td>IP ADDRESS</td>
<td></td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GATEWAY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAC ADDRESS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSID</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>VERSION(1)</strong></td>
<td>NETWORK TYPE</td>
<td></td>
</tr>
<tr>
<td>SECURITY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHANNEL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SIGNAL LEVEL</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>VERSION(2)</strong></td>
<td>FIRMWARE</td>
<td></td>
</tr>
<tr>
<td>DATA</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>OTHERS</strong></td>
<td>PROJECTOR NAME</td>
<td></td>
</tr>
<tr>
<td>HOST NAME</td>
<td>(B)</td>
<td></td>
</tr>
<tr>
<td>MODEL NO.</td>
<td>(B)</td>
<td></td>
</tr>
<tr>
<td>SERIAL NUMBER</td>
<td>(B)</td>
<td></td>
</tr>
<tr>
<td>LAN UNIT TYPE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONTROL ID (when [CONTROL ID] is set)</td>
<td>(B)</td>
<td></td>
</tr>
<tr>
<td><strong>RESET</strong></td>
<td>CURRENT SIGNAL</td>
<td></td>
</tr>
<tr>
<td>ALL DATA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.
Menu Descriptions & Functions [SOURCE]

HDMI1 and HDMI2
Selects the HDMI compatible equipment connected to your HDMI 1 IN or HDMI 2 IN terminal.

COMPUTER
Selects the computer connected to your COMPUTER input terminal signal.

NOTE: When the component input signal is connected to the COMPUTER IN terminal, select [COMPUTER].

VIDEO
Selects what is connected to your VIDEO input-VCR, DVD player or document camera.

HDBaseT
Projects the signal transmitted from the terminals supported HDBaseT. (→ page 80, 81)

APPS
Display the APPS MENU or the function in the APPS MENU that was used last time.
[ADJUST]

[PICTURE]

[PRESET]
This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta.
There are eight factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set
user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 8].

- HIGH-BRIGHT........ Recommended for use in a brightly lit room.
- PRESENTATION ...... Recommended for making a presentation using a PowerPoint file.
- VIDEO.................. Recommended for typical TV program viewing.
- MOVIE.................... Recommended for movies.
- GRAPHIC................ Recommended for graphics.
- sRGB..................... Standard color values
- NATURAL................ Well-balanced setting of brightness and color.
- DICOM SIM. .......... Recommended for DICOM simulation format.

**NOTE:**
- The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
- DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiology (ACR) and the National Electrical Manufacturers Association (NEMA).
  - The standard specifies how digital image data can be moved from system to system.
[DETAIL SETTINGS]

Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 8]. First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE].
- HIGH-BRIGHT: Recommended for use in a brightly lit room.
- PRESENTATION: Recommended for making a presentation using a PowerPoint file.
- VIDEO: Recommended for typical TV program viewing.
- MOVIE: Recommended for movies.
- GRAPHIC: Recommended for graphics.
- sRGB: Standard color values.
- NATURAL: Well-balanced setting of brightness and color.
- DICOM SIM: Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:
- DYNAMIC: Creates a high-contrast picture.
- NATURAL: Natural reproduction of the picture.
- BLACK DETAIL: Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.
- LARGE: For screen size of 110”
- MEDIUM: For screen size of 90”
- SMALL: For screen size of 70”

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Enhancing the Color [COLOR ENHANCEMENT]
This allows you to adjust the color density of the image. The color of the image will become deeper in the order of "LOW", "MEDIUM", AND "HIGH" as the displayed image will become darker. With "OFF" selected, the COLOR ENHANCEMENT function will not work.

NOTE: This function is available only when [PRESENTATION] is selected [REFERENCE].

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
If [ON] is selected, the most optimal contrast ratio is used according to the picture.

NOTE:
• The [DYNAMIC CONTRAST] item cannot be selected in the following either case:
  - When [ECO1] or [ECO2] is selected for [ECO MODE].
  - When [CONSTANT BRIGHTNESS] is enabled.
4. Using On-Screen Menu

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

[COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/- green to +/- blue. The red level is used as reference.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>CONTRAST</th>
<th>BRIGHTNESS</th>
<th>SHARPNESS</th>
<th>COLOR</th>
<th>HUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER/HDMI/HDBaseT (RGB)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>COMPUTER/HDMI/HDBaseT (COMPONENT)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VIDEO</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>APPS, LAN</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Yes = Adjustable, No = Not adjustable

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; Preset numbers and [REFERENCE] within the [PRESET] screen. The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected will not be reset.
[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK .................. Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be necessary when you connect your computer for the first time.

PHASE .................. Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident when part of your image appears to be shimmering.)
Use [PHASE] only after the [CLOCK] is complete.
4. Using On-Screen Menu

Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

- An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.
- The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, its adjustments will be called up and applied.
  To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] or [ALL DATA] and reset the adjustments.

Selecting Overscan Percentage [OVERSCAN]
This allows you to set the appropriate overscan for an incoming signal.
  AUTO .................. Display an appropriately overscanned image (factory setting).
  OFF  .................... Does not overscan the image.
  ON ...................... Overscans the image.

NOTE:
• The [OVERSCAN] item cannot be selected when VIDEO signals are used or when [NATIVE] is selected for [ASPECT RATIO].
Selecting Aspect Ratio [ASPECT RATIO]

The term “aspect ratio” refers to the ratio of width to height of a projected image. The projector automatically determines the incoming signal and displays it in its appropriate aspect ratio.

- This table shows typical resolutions and aspect ratios that most computers support.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA 640 x 480</td>
<td>4:3</td>
</tr>
<tr>
<td>SVGA 800 x 600</td>
<td>4:3</td>
</tr>
<tr>
<td>XGA 1024 x 768</td>
<td>4:3</td>
</tr>
<tr>
<td>WXGA 1280 x 768</td>
<td>15:9</td>
</tr>
<tr>
<td>WXGA 1280 x 800</td>
<td>16:10</td>
</tr>
<tr>
<td>WXGA+ 1440 x 900</td>
<td>16:10</td>
</tr>
<tr>
<td>SXGA 1280 x 1024</td>
<td>5:4</td>
</tr>
<tr>
<td>SXGA+ 1400 x 1050</td>
<td>4:3</td>
</tr>
<tr>
<td>UXGA 1600 x 1200</td>
<td>4:3</td>
</tr>
<tr>
<td>Full HD 1920 x 1080</td>
<td>16:9</td>
</tr>
<tr>
<td>WUXGA 1920 x 1200</td>
<td>16:10</td>
</tr>
</tbody>
</table>

Options Function

AUTO
The projector will automatically determine the incoming signal and display it in its aspect ratio. (→ next page)

4:3 The image is displayed in 4:3 aspect ratio.
16:9 The image is displayed in 16:9 aspect ratio.
15:9 The image is displayed in 15:9 aspect ratio.
16:10 The image is displayed in 16:10 aspect ratio.

LETTERBOX The image of a letterbox signal is stretched equally in the horizontal and vertical directions to fit the screen. Parts of the displayed image are cropped at the top and bottom edges and therefore not visible.

NATIVE The projector displays the current image in its true resolution when the incoming computer signal has a lower resolution than the projector’s native resolution.

[Example] When the incoming signal with the resolution of 800 x 600 is displayed:

NOTE:
- When a non-computer signal is displayed, the [NATIVE] is not available.
- When a signal with a higher resolution than the projector’s native resolution is displayed, [NATIVE] is not available.
Sample image when the appropriate aspect ratio is automatically determined

[Computer signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>5:4</th>
<th>16:9</th>
<th>15:9</th>
<th>16:10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>appropriate aspect ratio is</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>automatically determined</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Video signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>Letterbox</th>
<th>Squeeze</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>aspect ratio is automatically</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>determined</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOTE: To display a letterbox</td>
<td></td>
<td>NOTE: To display a squeezed signal</td>
<td></td>
</tr>
<tr>
<td>signal properly, select [LETTERBOX].</td>
<td></td>
<td>properly, select [16:9].</td>
<td></td>
</tr>
</tbody>
</table>

**TIP:**
- The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect ratio for a video source.
  The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
- The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

**Turning on Noise Reduction [NOISE REDUCTION]**
This function allows you to select the level of noise reduction.
The projector is set to the optimized level for each signal at the factory.
Select your preference item for your signal when video noise is noticeable.
The options are [OFF], [LOW], [MEDIUM], and [HIGH].

**NOTE:** This feature is not available for the RGB signal. Noise reduction set to off gives best image quality by way of higher bandwidth.
Noise reduction set to on softens the image.
5 Menu Descriptions & Functions [SETUP]

[GENERAL]

Correcting Keystone Distortion Manually [KEYSTONE]
You can correct horizontal or vertical keystone manually. [HORIZONTAL] and [VERTICAL] (simultaneously adjustable) correction can be selected.

NOTE:
- Some items are not available when one item is activated. Unavailable items are shown in grey.
- To change from one item to another item, reset the first item.
- Adjustment values will be overwritten. They will not be deleted even when the projector is turned off.
- Using [KEYSTONE] correction can cause the image to be slightly blurred because the correction is made electronically.

| HORIZONTAL | Corrects horizontal keystone distortion. (→ page 21) |
| VERTICAL | Corrects vertical keystone distortion. (→ page 21) |
| RESET | Returns all the above items to the factory preset values. |

TIP:
- The maximum adjustment range with [KEYSTONE] correction is ±25° in the horizontal direction, ±30° in the vertical direction.
  - Depending on input signal, the adjustable range may be narrower.
Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.

[LIGHT MODE]

Adjusting the energy savings settings and the brightness of each projector in multi-screen projection. For energy savings settings, see page 28 “4 Changing Eco Mode/Checking Energy-Saving Effect”.

<table>
<thead>
<tr>
<th>ECO MODE</th>
<th>OFF</th>
<th>The light module luminance (brightness) will be at the setup brightness for [ADJUST].</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ECO1</td>
<td>By controlling the brightness and fan speed according to the selected setting, energy can be saved and motion noise and the power consumption can be lowered. Can be selected when [CONSTANT BRIGHTNESS] mode is set to [OFF].</td>
</tr>
<tr>
<td></td>
<td>ECO2</td>
<td></td>
</tr>
</tbody>
</table>

| ADJUST   | Brightness can be adjusted in 1% increments from 16 to 100%. When several projectors are used for multi-screen projection, the brightness can be adjusted individually on each projector. The adjustment is valid when [ECO MODE] is set to [OFF] and [CONSTANT BRIGHTNESS] is set to [OFF]. |

<table>
<thead>
<tr>
<th>CONSTANT BRIGHTNESS</th>
<th>OFF</th>
<th>[CONSTANT BRIGHTNESS] mode will be canceled.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ON</td>
<td>Maintains 80% brightness of the factory default setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [CONSTANT BRIGHTNESS] mode is a function used to maintain the brightness at a constant level. Color will not be fixed.</td>
</tr>
</tbody>
</table>

TIP:
• Brightness normally decreases with use, but by selecting [CONSTANT BRIGHTNESS] mode, the projector automatically adjust the output based on the projector used time, thereby maintaining a constant brightness throughout the life of the light module. However, if output is already at its maximum, brightness will decrease with use.
Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video or S-Video.
- OFF ................. This exits the closed caption mode.
- CAPTION 1-4 ....... Text is superimposed.
- TEXT 1-4 ............ Text is displayed.

NOTE:
- The closed caption is not available under the following conditions:
  - when messages or menus are displayed.
  - when an image is magnified, frozen, or muted.
- Portions of superimposed text or closed caption may be truncated. If that happens, try to place the superimposed text or closed caption within the screen.
- The projector does not support optional extended characters for closed captioning.

Using Off Timer [OFF TIMER]
1. Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.
2. Press the ENTER button on the remote control.
3. The remaining time starts counting down.
4. The projector will turn off after the countdown is complete.

NOTE:
- To cancel the preset time, set [OFF] for the preset time or turn off the power.
- When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 MINUTES] message will be displayed on the bottom of the screen.

Display the tools menu [TOOLS]
This function display the tools menu. (→ page 91)

Selecting Menu Language [LANGUAGE]
You can choose one of 30 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [SOURCE DISPLAY]
This option turns on or off input name display such as HDMI1, HDMI2, COMPUTER, VIDEO, HDBaseT, APPS, to be displayed on the top right of the screen.
When no input signal is present, the no-signal guidance prompting you to check for an available input will be displayed at the center of the screen. When the [APPS] item is selected for [SOURCE], the no-signal guidance will not be displayed.

Turning ON/OFF Control ID [ID DISPLAY]
ID DISPLAY ........... This option turns on or off the ID number which is displayed when the ID SET button on the remote control is pressed.

Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the factory preset.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].

NOTE:
• If the [LOGO] item is selected for [BACKGROUND] with the [HDBaseT] source selected, the [BLUE] item will be selected regardless of its selection.
• When [SOURCE DISPLAY] is turned on, the no-signal guidance prompting you to check for an available input will be displayed at the center of the screen regardless of its selection.
• Your setting will not be affected even when [RESET] is done from the menu.

[3D CAUTION MESSAGE]
This selects whether to display a caution message or not when switching to a 3D video.
The default condition when shipped from the factory is ON.

OFF ....................... The 3D caution message screen will not be displayed.
ON .......................... The 3D caution message screen will be displayed when switching to a 3D video. Press the ENTER button to cancel the message.

• The message will disappear automatically after 60 seconds or when other buttons are pressed. If it disappears automatically, the 3D caution message will be displayed again when switching to a 3D video.
4. Using On-Screen Menu

[INSTALLATION]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

AUTO
When the light module is turned ON, the inner sensor of the projector detects its installation state either DESK FRONT or CEILING FRONT and then switch its projection method

<table>
<thead>
<tr>
<th>DESKTOP FRONT</th>
<th>CEILING REAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Desktop Front Image]</td>
<td>![Ceiling Rear Image]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DESKTOP REAR</th>
<th>CEILING FRONT</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Desktop Rear Image]</td>
<td>![Ceiling Front Image]</td>
</tr>
</tbody>
</table>

Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

**NOTE:**
- This CONTROL PANEL LOCK does not affect the remote control functions.
- How to release the CONTROL PANEL LOCK
  1. When the projector is projecting image or in the sleep mode, press and hold the SOURCE button on the projector cabinet for about 10 seconds. The CONTROL PANEL LOCK will be released.
  2. When the projector is in the standby mode, press and hold the POWER button on the projector cabinet. It enables to power on the projector. After checking the projector is projecting image, perform the previous step 1.

**TIP:** When the [CONTROL PANEL LOCK] is turned on, a key lock icon [ ] will be displayed at the bottom right of the menu.
4. Using On-Screen Menu

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function.
Unless the correct keyword is entered, the projector cannot project an image. (→ page 30)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 38400 bps. The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate may be recommended for long cable runs).

NOTE: Your selected communication speed will not be affected even when [RESET] is done from the menu.

Selecting the serial port [SERIAL PORT]
This sets which terminal on the projector will receive the serial control signals when operating the projector by remote control from a commercially available HDBaseT transmitter (control signals for turning the power on and off, etc.). There is no need to make this setting if not operating the projector by remote control (only sending video and audio).

PC CONTROL........ Control signals (RS232C serial communications) are received at the PC CONTROL terminal.
HDBaseT............. The video/audio and control signals (RS232C serial communications) are received at the Ethernet/HDBaseT port.

NOTE:
• When [HDBaseT] is set, the projector goes into the SLEEP mode regardless the setting for the standby mode (→ page 60) on the on-screen menu is [NORMAL] or [NETWORK STANDBY]. Based on this, the projector can be powered ON by an HDBaseT transmission device that is connected to the projector when the projector is in the standby mode. However, the standby mode setting cannot be changed when [HDBaseT] is set.
• While [HDBaseT] is set for the SERIAL PORT, power consumption in the standby mode becomes not to satisfy the energy saving regulation.

TIP:
• When controlling the projector using the LAN port, this works with either setting.

Turning On or Off Remote Sensor [REMOTE SENSOR]
Set the remote control sensors on the projector's front and rear panels and the HDBaseT remote control sensor. The options are: ALL, FRONT/BACK, FRONT, BACK, and HDBaseT.

TIP:
• If the remote control system does not function when direct sunlight or strong illumination strikes the remote control sensor of the projector, change another option.
• The remote control sensor on the back of the projector cannot be used when the separately sold cable cover is mounted on the projector.
Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER .... Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID ............... Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.

NOTE:
• When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
• Your setting will not be affected even when [RESET] is done from the menu.
• Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control ID.

Assigning or Changing the Control ID

1. Turn on the projector.
2. Press the ID SET button on the remote control.
The CONTROL ID screen will be displayed.

If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive projector, assign the control ID used for the projector by using the following procedure (Step 3).

3. Press one of numeric keypad buttons while pressing and holding the ID SET button on the remote control.
Example:
To assign “3”, press the “3” button on the remote control.
No ID means that all the projectors can be operated together with a single remote control. To set “No ID”, enter “000” or press the CLEAR button.
TIP: The range of IDs is from 1 to 254.

4. Release the ID SET button.
The updated CONTROL ID screen will be displayed.

NOTE:
• The IDs can be cleared in a few days after the batteries are run down or removed.
• Accidentally pressing any one of the buttons of the remote control will clear currently specified ID with batteries removed.
Using Test Pattern [TEST PATTERN]
Displays the test pattern for adjusting distortion on the screen and the focus at the time of the projector setup. Once the [TEST PATTERN] on the onscreen menu is selected, the pattern for adjustment will be displayed on. If you find distortion on the pattern, adjust the projector installation angle or correct distortion by pressing the KEYSTONE button on the remote. If the focus adjustment is required, control the focus lever. Recommend to perform the focus adjustment after leaving the projector under the state the TEST PATTERN has been projected for over 30 minutes. Press EXIT button to close the test pattern and return to the menu.

Setting the network [NETWORK SETTINGS]
This function display the network settings menu. (→ page 90)
4. Using On-Screen Menu

[OPTIONS(1)]

Selecting Fan Mode [FAN MODE]
Fan Mode is used to set the speed of the internal cooling fan.

AUTO .................. The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH .................... The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 5500 feet/1700 meters or higher.

NOTE:
• It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
• Set [FAN MODE] to [HIGH] when using the projector at altitudes approximately 5500 feet/1700 meters or higher.
• Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
• Using the projector at altitudes approximately 5500 feet/1700 meters or higher can shorten the life of optical components such as the light module.
• Your setting will not be affected even when [RESET] is done from the menu.

Enabling or Disabling WXGA Mode [WXGA MODE]
Selecting [ON] will give priority to WXGA (1280 × 768)/WUXGA (1920 × 1200) signals in recognizing an input signal. When [WXGA MODE] is set to [ON], XGA (1024 × 768)/UXGA (1600 × 1200) signals may not be recognized. In this case, select [OFF].

NOTE:
• The [ON] is selected at the time of shipment.

Selecting Still Image Mode or Movie Mode [IMAGE MODE]
This function allows you to select the still image mode or the movie mode.

NOTE:
• This mode may not be available depending on input signal.
Setting HDMI1, HDMI2, or HDBaseT [HDMI SETTINGS]
Make the settings for each video level when connecting HDMI equipment and Ethernet/HDBaseT terminal.

VIDEO LEVEL........ Select [AUTO] to automatically detect video level. If automatic detection may not work well, select [NORMAL] to disable the [ENHANCED] feature of your HDMI equipment or select [ENHANCED] to improve image contrast and increase detail in the dark areas.

Setting Audio [AUDIO SELECT]
Make the settings for each audio level when connecting HDMI equipment and Ethernet/HDBaseT terminal. Select between each equipment and computer.

HDMI1, HDMI2........... Select [HDMI1] or [HDMI2] to switch the HDMI 1 IN or HDMI 2 IN digital audio signal or select [COMPUTER] to switch the COMPUTER input audio signal.

HDBaseT................. Select [HDBaseT] or [COMPUTER] to switch the source connected to the network.

Enabling Key Sound and Error Sound [BEEP]
This feature turns on or off the button sound or alarm when an error occurs or the following operations are performed.

- Displaying the main menu
- Switching sources
- Resetting data by using [RESET]
- Pressing POWER ON or STANDBY button
4. Using On-Screen Menu

[OPTIONS(2)]

Selecting Power-saving in [STANDBY MODE]
The projector has two standby modes: [NORMAL] and [NETWORK STANDBY]. The NORMAL mode is the mode that allows you to put the projector in the power-saving condition which consumes less power than the NETWORK STANDBY mode.

NORMAL........................POWER indicator: Red light/STATUS indicator: Off
When [NORMAL] is selected, only the following buttons and feature will work:
POWER button on the projector cabinet and the remote control, powering on from PC Control command, and AUTO POWER ON.

NETWORK STANDBY...POWER indicator: Orange light/STATUS indicator: Off
When [NETWORK STANDBY] is selected, the projector can be turned on over a wired LAN/wireless LAN connection and only the following buttons, terminals, and features will work:
POWER button on the projector cabinet and the remote control, powering on from PC Control command, AUTO POWER ON, Operation by User Supportware, Network service, Program Timer.

Important:
• When [NETWORK STANDBY] has been set for [STANDBY MODE] and the LAN has been in link-down condition for 3 minutes, [STANDBY MODE] will transit into [NORMAL] automatically for the purpose to save the consumption power.
• When [NETWORK STANDBY] is selected, [AUTO POWER OFF] will turn in grey and be disabled and [0:10] will be selected automatically for [AUTO POWER OFF].
• In the below conditions, setting of the [STANDBY MODE] is disabled and the projector will go into the SLEEP mode*.
  * Sleep mode refers the mode without functional restrictions by the [STANDBY MODE]. Power consumption in the SLEEP mode is relatively higher than the [NETWORK STANDBY] mode. The Status indicator turns on in Green.
When [STANDBY MODE] → [NETWORK STANDBY] is selected
- When [NETWORK SERVICE] → [AMX SETTINGS] → [ENABLE] is selected
- When [NETWORK SERVICE] → [CRESTRON SETTINGS] → [CRESTRON CONTROL] → [ENABLE] is selected
- When [NETWORK SETTINGS] → [WIRELESS LAN] → Except for [DISABLE] and mounting the wireless LAN unit to the projector
- When the signal is input to the computer, HDMI 1 IN or HDMI 2 IN terminals

TIP:
• Even when [NORMAL] is selected for [STANDBY MODE], power on or off can be done by using the PC CONTROL port.
• The power consumption in the standby mode will not be included in calculating CO₂ emission reduction.
• Your setting will not be affected even when [RESET] is done from the menu.

Enabling Direct Power On [DIRECT POWER ON]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the need to always use the POWER button on the remote control or projector cabinet.
4. Using On-Screen Menu

Turning On the Projector By Applying Computer Signal [AUTO POWER ON]

When the projector is in Standby mode, applying a computer or HDMI signal from a computer connected to the COMPUTER IN input, HDMI1, or HDMI2 input will power on the projector and simultaneously project the image. This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet to power on the projector.

To use this function, first connect a computer to the projector and the projector to an active AC input.

**NOTE:**
- Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in combination of the AUTO POWER OFF function.
- This function will not be available under the following conditions:
  - when a component signal is applied to the COMPUTER IN terminal
  - when a Sync on Green RGB signal or composite sync signal is applied
- To enable the AUTO POWER ON after changing to the sleep mode turning off the projector, wait 5 seconds and input a computer or HDMI signal.
  
  If a computer or HDMI signal is still present when the projector is turned off, the AUTO POWER ON will not work and the projector remains in standby mode.

Enabling Power Management [AUTO POWER OFF]

The projector has power management functions. To reduce power consumption, the power management functions (1 and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable connection, use the on-screen menu to change the settings for 1 and 2.

1. **STANDBY MODE (Factory preset: NORMAL)**
   
   To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

   **NOTE:**
   - When [NORMAL] is selected for [STANDBY MODE], the following terminals and functions will not work:
     - MONITOR OUT (COMP.) terminal, AUDIO OUT terminal, LAN functions, Mail Alert function, DDC/CI (Virtual Remote Tool)

2. **AUTO POWER OFF (Factory preset: 1 hour)**
   
   To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

   **NOTE:**
   - When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is no signal received by any input or if no operation is performed.
Selecting Default Source [DEFAULT SOURCE SELECT]

You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST .................. Sets the projector to default to the previous or last active input each time the projector is turned on.
AUTO .................. Searches for an active source in order of [HDMI1] → [HDMI2] → [COMPUTER] → [VIDEO] → [HDBaseT] → [APPS] and displays the first found source.
HDMI1 .................. Displays the digital source from the HDMI 1 IN terminal every time the projector is turned on.
HDMI2 .................. Displays the digital source from the HDMI 2 IN terminal every time the projector is turned on.
COMPUTER .............. Displays the computer signal from the COMPUTER IN terminal every time the projector is turned on.
VIDEO .................. Displays the Video source from the VIDEO IN terminal every time the projector is turned on.
HDBaseT ................. Projects the signal transmitted from the terminals supported HDBaseT.
APPS .................... Display the APPS MENU.

NOTE:
• [APPS] can not be detected when [AUTO] is selected. For projecting image from APPS, select [APPS] or [LAST].
4. Using On-Screen Menu

[3D]

Selecting input connected to a source of 3D images [HDMI1/HDMI2/COMPUTER/VIDEO/HDBaseT]

[3D]
This function switches the 3D mode between ON and OFF for each input.
ON .................... Turns on the 3D mode for the selected input.

NOTE:
To confirm that the supported 3D signal is accepted, use either way of the following:
• Make sure that [3D] is displayed in the top right of the screen after the source is selected.
• Display [INFO.] → [SOURCE(2)] → [3D SIGNAL] and make sure that “SUPPORTED” is displayed.

OFF .................... Turns off the 3D mode for the selected input.

[GLASSES]
Select 3D glasses method.
DLP® Link............. For 3D eyeglasses (ones manufactured by XPAND are recommended) or DLP® Link compatible LCD shutter eyeglasses.
Others................. For other LCD shutter eyeglasses such as IR or wired LCD shutter types.

NOTE:
• When using crystal shutter glasses other than those using the DLP® Link method, it may not be possible to synchronize, depending on the glasses.
• This function will not work for VIDEO source.

[FORMAT]
Sets 3D format.
AUTO ...................... Automatically selects the appropriate format. The supported format is HDMI 3D only.
FRAME PACKING ......... Selects this format for the FRAME PACKING 3D image. FRAME PACKING is a format that stores the left and right eye images without compression.
SIDE BY SIDE ............ Selects this format for the SIDE BY SIDE 3D image. SIDE BY SIDE is a format that stores the left and right eye images displayed horizontally. Only the half of the horizontal resolution is supported.
TOP AND BOTTOM ....... Selects this format for the TOP AND BOTTOM 3D image. TOP AND BOTTOM is a format that stores the left and right eye images displayed vertically. Only the half of the vertical resolution is supported.
FRAME SEQUENTIAL ....... Selects this format for the FRAME SEQUENTIAL 3D image. FRAME SEQUENTIAL is a format that displays the left and right eye images alternately.

NOTE:
• This function will not work for VIDEO source.
• When 3D signals are input, operation is only possible when [GLASSES] is set to “DLP® Link”.

63
4. Using On-Screen Menu

[L/R INVERT]
Change the setting if you have difficulty seeing 3D images.

   NON-INVERT .......... Normal setting.
   INVERT ................ Changes the order of displaying the images for left eye and right eye.

NOTE:
• When [L/R INVERT] cannot be operated, the [L/R INVERT] screen will not be displayed even when the remote control’s video button is pressed.
4. Using On-Screen Menu

6 Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and light module usage. This item has nine pages. The information included is as follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]
[LIGHT HOURS USED] (H)
[TOTAL CARBON SAVINGS] (kg-CO2)

• [TOTAL CARBON SAVINGS]
  This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving calculation is based on the OECD (2008 Edition). (→ page 29)

[SOURCE(1)]
[RESOLUTION]
[VERTICAL FREQUENCY]
[SYNC POLARITY]
[HORIZONTAL FREQUENCY]
[SYNC TYPE]
[SCAN TYPE]

[SOURCE(2)]
[SIGNAL TYPE]
[BIT DEPTH]
[3D SIGNAL]
[VIDEO TYPE]
[VIDEO LEVEL]

[HDBaseT]
[SIGNAL QUALITY]
[LINK STATUS]
[OPERATION MODE]
[HDMI STATUS]

[WIRED LAN]
[IP ADDRESS]
[GATEWAY]
[SUBNET MASK]
[MAC ADDRESS]

[WIRELESS LAN]
[IP ADDRESS]
[GATEWAY]
[SSID]
[SECURITY]
[SIGNAL LEVEL]
[SUBNET MASK]
[MAC ADDRESS]
[NETWORK TYPE]
[CHANNEL]

[VERSION(1)]
[FIRMWARE] Version
[DATA] Version

[VERSION(2)]
[FIRMWARE2] Version

[OTHERS]
[PROJECTOR NAME]
[MODEL NO.]
[LAN UNIT TYPE]
[HOST NAME]
[SERIAL NUMBER]
[CONTROL ID] (when [CONTROL ID] is set)
Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source(s) except the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels. The items that can be reset are: [Preset], [Contrast], [Brightness], [Color], [Hue], [Sharpness], [Aspect Ratio], [Horizontal], [Vertical], [Clock], [Phase], and [Overscan].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset. All items can be reset EXCEPT [Language], [Background], [Orientation], [Serial Port], [Security], [Communication Speed], [Control ID], [Standby Mode], [Fan Mode], [Light Hours Used], [Total Carbon Savings], [Projector Name], [Wired LAN], [Wireless LAN], [MultiPresenter], [Network Service], [Date & Time], [Administrator Mode], and [Remote Desktop Connection].
5. Installation and Connections

Setting Up the Screen and the Projector

Use this to get a general idea of what the screen size will be when set in a certain position, what size screen you will need, and what distance you will need to project images of the desired size.

The projection distance range at which focusing is possible is 0.79 m (for a 30 model) to 14.19 m (for a 300 model). Install within this range.

[P502HL-2]

* The figures indicated for “height of screen from projector lens center” on the projection distance table are for a lens shift of 62% V.

[Reading the Table]
From the upper table on this page, to project wide images on a 150 screen, install at about 4.1 m from the front. Also, from the lower table we can see that about 2.1 m are required from the projector’s lens center to the upper edge of the screen. Use this to see whether or not enough height can be provided from the projector to the ceiling and for installing the screen. The diagram shows the projection distance when the projector is installed horizontally. The projected image can be moved up and down, left and right using the lens shift function. (→ page 17)
5. Installation and Connections

[Reading the Table]
From the upper table on this page, to project wide images on a 150 screen, install at about 4.1 m from the front. Also, from the lower table we can see that about 2.1 m are required from the projector’s lens center to the upper edge of the screen. Use this to see whether or not enough height can be provided from the projector to the ceiling and for installing the screen. The diagram shows the projection distance when the projector is installed horizontally. The projected image can be moved up and down, left and right using the lens shift function. (→ page 17)

* The figures indicated for “height of screen from projector lens center“ on the projection distance table are for a lens shift of 59% V.
5. Installation and Connections

Tables of screen sizes and dimensions

[P502HL-2]

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (cm)</th>
<th>Screen height (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>66.4</td>
<td>37.4</td>
</tr>
<tr>
<td>40</td>
<td>88.6</td>
<td>49.8</td>
</tr>
<tr>
<td>50</td>
<td>110.7</td>
<td>62.3</td>
</tr>
<tr>
<td>60</td>
<td>132.8</td>
<td>74.7</td>
</tr>
<tr>
<td>80</td>
<td>177.1</td>
<td>99.6</td>
</tr>
<tr>
<td>100</td>
<td>221.4</td>
<td>124.5</td>
</tr>
<tr>
<td>120</td>
<td>265.7</td>
<td>149.4</td>
</tr>
<tr>
<td>150</td>
<td>332.1</td>
<td>186.8</td>
</tr>
<tr>
<td>200</td>
<td>442.8</td>
<td>249.1</td>
</tr>
<tr>
<td>250</td>
<td>553.4</td>
<td>311.3</td>
</tr>
<tr>
<td>300</td>
<td>664.1</td>
<td>373.6</td>
</tr>
</tbody>
</table>

[P502WL-2]

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (cm)</th>
<th>Screen height (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>64.6</td>
<td>40.4</td>
</tr>
<tr>
<td>40</td>
<td>86.2</td>
<td>53.8</td>
</tr>
<tr>
<td>50</td>
<td>107.7</td>
<td>67.3</td>
</tr>
<tr>
<td>60</td>
<td>129.2</td>
<td>80.8</td>
</tr>
<tr>
<td>80</td>
<td>172.3</td>
<td>107.7</td>
</tr>
<tr>
<td>100</td>
<td>215.4</td>
<td>134.6</td>
</tr>
<tr>
<td>120</td>
<td>258.5</td>
<td>161.5</td>
</tr>
<tr>
<td>150</td>
<td>323.1</td>
<td>201.9</td>
</tr>
<tr>
<td>200</td>
<td>430.8</td>
<td>269.2</td>
</tr>
<tr>
<td>250</td>
<td>538.5</td>
<td>336.5</td>
</tr>
<tr>
<td>300</td>
<td>646.2</td>
<td>403.9</td>
</tr>
</tbody>
</table>
5. Installation and Connections

Example of installation on a desktop

The diagram below shows an example of when the projector is used on a desktop.

Horizontal projection position: Equal distance to the left and right from the center of the lens

Vertical projection position: (see table below)

[P502HL-2]

(Note) Height from lens center to lower edge of screen (with tilt feet screwed in)

<table>
<thead>
<tr>
<th>Screen size (inches)</th>
<th>Throw distance L (m)</th>
<th>Height H (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Wide</td>
<td>Tele</td>
</tr>
<tr>
<td>30</td>
<td>0.79</td>
<td>1.39</td>
</tr>
<tr>
<td>40</td>
<td>1.07</td>
<td>1.86</td>
</tr>
<tr>
<td>50</td>
<td>1.34</td>
<td>2.34</td>
</tr>
<tr>
<td>60</td>
<td>1.62</td>
<td>2.81</td>
</tr>
<tr>
<td>80</td>
<td>2.17</td>
<td>3.76</td>
</tr>
<tr>
<td>100</td>
<td>2.72</td>
<td>4.71</td>
</tr>
<tr>
<td>120</td>
<td>3.28</td>
<td>5.66</td>
</tr>
<tr>
<td>150</td>
<td>4.11</td>
<td>7.08</td>
</tr>
<tr>
<td>200</td>
<td>5.49</td>
<td>9.45</td>
</tr>
<tr>
<td>250</td>
<td>6.87</td>
<td>11.82</td>
</tr>
<tr>
<td>300</td>
<td>8.25</td>
<td>14.19</td>
</tr>
</tbody>
</table>

[P502WL-2]

(Note) Height from lens center to lower edge of screen (with tilt feet screwed in)

<table>
<thead>
<tr>
<th>Screen size (inches)</th>
<th>Throw distance L (m)</th>
<th>Height H (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Wide</td>
<td>Tele</td>
</tr>
<tr>
<td>30</td>
<td>0.81</td>
<td>1.42</td>
</tr>
<tr>
<td>40</td>
<td>1.09</td>
<td>1.90</td>
</tr>
<tr>
<td>50</td>
<td>1.37</td>
<td>2.39</td>
</tr>
<tr>
<td>60</td>
<td>1.66</td>
<td>2.87</td>
</tr>
<tr>
<td>80</td>
<td>2.22</td>
<td>3.84</td>
</tr>
<tr>
<td>100</td>
<td>2.78</td>
<td>4.81</td>
</tr>
<tr>
<td>120</td>
<td>3.35</td>
<td>5.78</td>
</tr>
<tr>
<td>150</td>
<td>4.19</td>
<td>7.23</td>
</tr>
<tr>
<td>200</td>
<td>5.60</td>
<td>9.65</td>
</tr>
<tr>
<td>250</td>
<td>7.01</td>
<td>12.08</td>
</tr>
<tr>
<td>300</td>
<td>8.43</td>
<td>14.50</td>
</tr>
</tbody>
</table>
5. Installation and Connections

**Lens shifting range**
This projector is equipped with a lens shift function (→ page 17) for adjusting the image position using dials. Lens shifting is possible within the range shown below.

**NOTE:**
- In case lens shifted volume exceeds the below illustrated range, blur and shade may appear around ends of projected image.

Legend: V “Vertical” refers to the screen height and H “Horizontal” refers to the screen width. The lens shift range is expressed as a ratio of height and width, respectively.

**[P502HL-2]**
Lens shifting range:
Vertical direction: +62%, –0%
Horizontal direction: ±25%

**[P502WL-2]**
Lens shifting range:
Vertical direction: +59%, –0%
Horizontal direction: ±28%

* The lens shift range is the same for ceiling installation.
(Example) When using to project on a 150” screen

**[P502HL-2]**
According to the “Table of screen sizes and dimensions” (→ page 70), \( H = 130.8”/332.1 \text{ cm}, \ V = 73.6”/186.8 \text{ cm}. \)
Adjustment range in the vertical direction: the projected image can be moved upwards \( 0.62 \times 73.6”/186.8 \text{ cm} = 45.3”/115 \text{ cm} \) (when the lens is at the center position).
Adjustment range in the horizontal direction: the projected image can be moved to the left \( 0.25 \times 130.8”/332.1 \text{ cm} = 32.7”/83 \text{ cm}, \) to the right approximately \( 32.7”/83 \text{ cm}. \)

**[P502WL-2]**
According to the “Table of screen sizes and dimensions” (→ page 70), \( H = 127.3”/323.1 \text{ cm}, \ V = 79.5”/201.9 \text{ cm}. \)
Adjustment range in the vertical direction: the projected image can be moved upwards \( 0.59 \times 79.5”/201.9 \text{ cm} = 46.9”/119 \text{ cm} \) (when the lens is at the center position).
Adjustment range in the horizontal direction: the projected image can be moved to the left \( 0.28 \times 127.3”/323.1 \text{ cm} = 35.4”/90 \text{ cm}, \) to the right approximately \( 35.4”/90 \text{ cm}. \)

* Figures differ by several % because the calculation is approximate.

**WARNING**
* Installing your projector on the ceiling must be done by a qualified technician. Contact your NEC dealer for more information.
* Do not attempt to install the projector yourself,
  • Only use your projector on a solid, level surface. If the projector falls to the ground, you can be injured and the projector severely damaged.
  • Do not use the projector where temperatures vary greatly. The projector must be used at temperatures between 41°F (5°C) and 104°F (40°C) (Eco mode selected automatically at 95°F to 104°F/35°C to 40°C).
  • Do not expose the projector to moisture, dust, or smoke. This will harm the screen image.
  • Ensure that you have adequate ventilation around your projector so heat can dissipate. Do not cover the vents on the side or the front of the projector.

**Reflecting the Image**
Using a mirror to reflect your projector’s image enables you to enjoy a much larger image when a smaller space is required. Contact your NEC dealer if you need a mirror system. If you’re using a mirror system and your image is inverted, use the MENU and ▲▼◀▶ buttons on your projector cabinet or your remote control to correct the orientation. (→ page 54)
5. Installation and Connections

2 Making Connections

Connecting Your Computer
Computer cables and HDMI can be used to connect to a computer. The HDMI cable is not enclosed with the projector. Please get ready a suitable cable for the connection.

NOTE: Signals supported by Plug & Play (DDC2)

<table>
<thead>
<tr>
<th>INPUT</th>
<th>COMPUTER IN</th>
<th>HDMI 1 IN</th>
<th>HDMI 2 IN</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>analog</td>
<td>digital</td>
<td>digital</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

HDMI cable (not supplied)
Use High Speed HDMI® Cable.

Computer cable (VGA) (supplied)
To mini D-Sub 15-pin terminal on the projector. It is recommended that you use a commercially available distribution amplifier if connecting a signal cable longer than the cable supplied.

NOTE: For Mac, use a commercially available pin adapter (not supplied) to connect to your Mac’s video port.

• Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI 1 IN</td>
<td>HDMI1</td>
<td>(HDMI 1*)</td>
</tr>
<tr>
<td>HDMI 2 IN</td>
<td>HDMI2</td>
<td>(HDMI 2*)</td>
</tr>
<tr>
<td>COMPUTER IN</td>
<td>COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
</tbody>
</table>
5. Installation and Connections

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.

NOTE: An image may not be displayed correctly when a Video source is played back via a commercially available scan converter. This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.

* When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:
  Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.

Enabling the computer’s external display
Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

Cautions when using a DVI signal

- When the computer has a DVI output terminal, use a commercially available converter cable to connect the computer to the projector’s HDMI 1 IN or HDMI 2 IN terminal (only digital video signals can be input).

NOTE: When Viewing a DVI Digital Signal

- Turn off the power of the computer and projector before connecting.
- When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.
- Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 standard.
  The cable should be within 197'/5 m long.
- Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
- To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC. Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, restart your PC.
- Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
- The COMPUTER video input terminals support Windows Plug and Play.
- A Mac signal adapter (commercially available) may be required to connect a Mac computer.
Connecting an External Monitor
You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer analog image you’re projecting.

NOTE:
• The AUDIO OUT mini jack does not support Headphone terminal.
• When audio equipment is connected, the projector speaker is disabled.
• The signal output from the MONITOR OUT (COMP.) of this projector is for projecting image on exclusive one display.
• When no signal is applied over 3 minutes in the condition of projector standby when NETWORK STANDBY is set in the Standby mode, output from the MONITOR OUT (COMP.) or AUDIO OUT terminal will be stopped. In this case pull out the computer cable and set it back after inputting video signal.

Monitor out and sleep mode:
• The MONITOR OUT (COMP.) terminal will not work when [NORMAL] is selected for [STANDBY MODE]. The MONITOR OUT (COMP.) terminal will work only in the sleep mode.
Applying a signal from the COMPUTER IN terminal will put the projector in the sleep mode, which allows you to use the MONITOR OUT (COMP.) terminal and the AUDIO OUT mini jack.
The sleep mode is one of the standby modes. The sleep mode cannot be selected from the menu.
• In the network standby mode, sound for the last viewed computer or video source will be heard.
BNC-to- COMPUTER IN terminal converted signal will not be output in the standby mode and sleep mode.
5. Installation and Connections

Connecting Your DVD Player or Other AV Equipment

Connecting Video Input

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO IN</td>
<td>(VIDEO)</td>
<td>(VIDEO)</td>
</tr>
</tbody>
</table>

**NOTE:** Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

**NOTE:** An image may not be displayed correctly when a Video source is played back in fast-forward or fast-rewind via a scan converter.
Connecting Component Input

Connection for component signal. Signal from the color difference signal output terminal on DVD players (DVD video output) and the YPbPr output terminal on the Hi-vision video can be projected. Recommend to connect the terminal for audio output on the DVD player to the audio components.

![Diagram of connecting component input](image)

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
</tbody>
</table>

**NOTE:** Refer to your DVD player’s owner’s manual for more information about your DVD player’s video output requirements.
**Connecting HDMI Input**

You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the HDMI IN terminal of your projector.

- **HDMI cable (not supplied)**
  Use High Speed HDMI® Cable.

- **Audio cable (not supplied)**

- **Input terminal**
- **SOURCE button on the projector cabinet**
- **Button on the remote control**

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI 1 IN</td>
<td>HDMI1</td>
<td>(HDMI1*)</td>
</tr>
<tr>
<td>HDMI 2 IN</td>
<td>HDMI2</td>
<td>(HDMI2*)</td>
</tr>
</tbody>
</table>

- Select the source name for its appropriate input terminal after turning on the projector.

- When connecting the HDMI 1 IN terminal (or HDMI 2 IN terminal) of the projector to the DVD player, the projector’s video level can be made settings in accordance with the DVD player’s video level. In the menu select [HDMI SETTINGS] → [VIDEO LEVEL] and make necessary settings.

- If the HDMI input sound cannot be heard, in the menu select [AUDIO SELECT] → [HDMI1] or [HDMI2]. (→ page 59)
5. Installation and Connections

Connecting your document camera
You can connect your document camera and project printed documents, etc.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>📱 COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
<tr>
<td>VIDEO IN</td>
<td>📀 VIDEO</td>
<td>(VIDEO)</td>
</tr>
</tbody>
</table>

Name, position, and direction of terminals are vary depending on camera model. Please check user's manual of your camera for details.
5. Installation and Connections

Connecting to a Wired LAN
The projector comes standard with the Ethernet/HDBaseT port (RJ-45) and the LAN port which provide a LAN connection using a LAN cable.
To use a LAN connection, you are required to set the wired LAN settings on the projector menu. Select [SETUP] → [INSTALLATION] → [NETWORK SETTINGS]. (→ page 57).
The network settings can also be selected from the APPS menu.

Example of LAN connection
Example of wired LAN connection

NOTE:
• About the projector’s Ethernet/HDBaseT and LAN ports
  The Ethernet/HDBaseT and LAN ports are the same, aside from the HDBaseT function. To connect to the LAN, use only 1 of the ports (it is not possible to connect both ports to the LAN).
  For controlling the projector by a HDBaseT transmitter whose control signal is not supported (or with which cannot connect the projector) or over the network, connect to the LAN port. At the same time, for controlling the projector over the network that is in the state of the NETWORK STANDBY On, connect to the LAN port.

NOTE: Use a Category 5 or higher LAN cable.
Connecting to a Wireless LAN (Optional: NP05LM series)
The USB Wireless LAN Unit also provides a wireless LAN connection. To use a wireless LAN connection, you are required to assign an IP address to the projector.

Important:
• If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is prohibited, remove the USB Wireless LAN Unit from the projector.
• Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE:
• Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11a/b/g/n) standard.

Attaching the USB Wireless LAN Unit

NOTE:
• The USB Wireless LAN Unit must be inserted into the USB Wireless LAN Unit port in the correct direction. It cannot be inserted in the reverse direction. If the USB Wireless LAN Unit is inserted in the reverse direction with excessive force applied, the USB port may break.
• Before touching the USB Wireless LAN Unit, touch a metallic object (such as a door knob or aluminum window frame) to discharge the static electricity from your body.
• Always insert or remove the USB Wireless LAN unit when the main power is turned off. Failure to do so may cause projector malfunction or damage to the USB wireless LAN unit. If the projector will not work correctly, turn off the projector, disconnect the power cord, and then connect it again.
• Do not insert other USB devices into the USB (wireless LAN) port in the wireless LAN cover. Do not insert the USB Wireless LAN unit into the USB port.

NOTE: When the cable cover is attached, remove it before inserting the USB Wireless LAN Unit.

1. Press the POWER button to turn off the projector and set it into standby condition, and disconnect the power cord.
2. Remove the wireless LAN cover.
   (1) Turn the screw counterclockwise until it turns freely.

   (2) Hold the head of the screw and remove.
3. Insert the wireless LAN unit into the USB (wireless LAN) port with the side containing the indicator facing up.
   - Slowly slide the wireless LAN unit left and right, up and down, checking the insertion slot as you push the unit in.

   **NOTE:** Do not force to insert the USB Wireless LAN Unit.

4. Mount the wireless LAN cover.
   1. Insert the hook on the back of the cover into the groove in the projector and close the wireless LAN cover.

   (2) Turn the screw clockwise to tighten it.

   * To remove the USB Wireless LAN Unit, disconnect the power cord and use the above procedure.

   **NOTE:**
   - Do not press the button on the USB Wireless LAN Unit. The button does not work with this model.
Example of wireless LAN connection

To use a LAN connection, you are required to set the Wireless LAN settings on the projector menu. Select [SETUP] → [INSTALLATION] → [NETWORK SETTINGS]. (→ page 57).

The network settings can also be selected from the APPS menu.
Connecting to a HDBaseT transmission device (sold commercially)

HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance. Use a LAN cable sold commercially to connect the Ethernet / HDBaseT port of the projector (RJ-45) to a HDBaseT transmission device sold commercially. The Ethernet/HDBaseT port of the projector supports HDMI signals (HDCP) from transmission devices, control signals from external devices (serial, LAN) and remote control signals (IR commands).

Connection example
NOTE:
- Please use a shielded twisted pair (STP) cable of Category 5e or higher for the LAN cable (sold commercially).
- The maximum transmission distance over the LAN cable is 100 m.
- Please do not use other transmission equipment between the projector and transmission equipment. The picture quality may be deteriorated as a result.
- This projector is not guaranteed to work with all HDBaseT transmission devices sold commercially.
Portrait projection (vertical orientation)

Portrait screens from a computer can be projected by installing the projector in a vertical orientation. All the screens such as the on-screen menu will be rotated in a counter-clockwise direction. The projector is equipped with a sensor to automatically detect the installation state.

⚠️ Precautions during installation

- Please do not install the projector in a vertical orientation on top of the floor or table on its own. The intake vent may be obstructed, resulting in the projector getting warm and the possibility of fire and malfunction occurring.
- For vertical installation, install the projector with the intake vent facing downwards. A stand for supporting the projector needs to be made for this purpose. In this case, the stand must be designed such that the center of gravity of the projector is located well within the legs of the stand. If not, the projector may fall over and result in injury, damage and malfunction.
**5. Installation and Connections**

**Design and manufacturing conditions for the stand**

Please engage an installation service provider for the design and manufacture of the customized stand to be used for portrait projection. Please ensure that the following are complied with when designing the stand.

1. Maintain a distance of at least 100 mm between the projector intake vent and the floor.
   - Do not obstruct the intake vent at the front of the projector.

2. Use the four screw holes on the bottom face of the projector to secure it to the stand.
   - Screw hole center dimension: 200 × 250 mm
   - Screw hole dimension on the projector: M4 with a maximum depth of 8 mm.
   - Please design the stand such that the rear legs on the bottom face of the projector do not contact the stand.
     - The front legs can be turned and removed.

3. Horizontal adjustment mechanism (for example, bolts and nuts in four locations)

4. Please design the stand such that it does not topple over easily.

---

**Reference drawings**

* The drawing showing the dimensional requirements is not an actual stand design drawing.

(Unit: mm)

---

![Reference drawings](image-url)
6. APPS MENU

What can you do with the APPS MENU?

It becomes available to select the expansion functions indicated in below and various settings with the APPS MENU. For displaying the APPS MENU, press the APPS button on the remote or select [APPS] as the [SOURCE] on the onscreen menu.

INFORMATION

Detailed information about each function on the APPS MENU is explained on our website. Please search it by the model name of your projector.


APPs MENU screen display

REMOTE DESKTOP CONNECTION

MultiPresenter

VIEWER

Miracast

FOCUS

Indicating the selected item. Surrounded in a yellow square.

Wireless LAN profile selection

NETWORK SETTINGS

WEB SHARING SETTING/DISPLAYING ACCESS PASSWORD

TOOLS

PIN CODE (4-digit number) for connecting with MultiPresenter application

NETWORK INFORMATION

Current date and time

Important: Before utilizing the function of APPS MENU, set day and time.

NOTE:

• When this projector is not in a network, you cannot select [REMOTE DESKTOP CONNECTION], [MultiPresenter], [Miracast], and [WEB SHARING].
VIEWER
This is used to select a saved image or video and project it from the projector. The three types below can be used.
(1) Projector Memory: Images and videos temporarily saved in the projector’s internal memory.
(2) USB Memory: Images and videos saved in the USB memory connected with the projector.
(3) Common Folder: Images and videos saved in the common folder in a network connected with the projector.

REMOTE DESKTOP CONNECTION
• Select the computer connected in the same network with the projector, and the projector projects the images on the computer over the network.
  A commercially available USB keyboard can be used for controlling Windows 8 and Windows 7 computers connected in the network with the projector.

MultiPresenter
• If various terminal units such as a computer, a smartphone, and a tablet are connected with the projector in the network, it enables to transfer images saved on each terminal to the projector and to project them.
• You can connect terminal units in multiple OS (Windows, OS X, Android, and iOS) with the projector simultaneously.
• The projector receives images transferred from multiple terminal units (Max. 50 units) and projects them on the screen dividing it (Max. 4 x 4) at the same time.

• Install the application software “Image Express Utility Lite”, included in the CD-ROM supplied with the projector on computers. (→ page 94, 97)
• Or download the application software “MultiPresenter” from the home page of MultiPresenter, and install it on your computer or smartphone.
• For details on the MultiPresenter application, please refer to page 112.

Miracast
By wirelessly connecting the terminal units supporting the Miracast such as the Android with the projector, it enables the projector to project images transferred from these terminals.
Before connecting these terminal units, set [Miracast] in the [NETWORK SETTINGS] on the projector.
WEB SERVER FUNCTION

WEB SHARING
Without using the exclusive software, it enables to share images and files among the projector and computers in the same network by accessing the web server of the projector utilizing the web browser.

MultiPresenter
It enables to control displaying position of the images that are simultaneously transferred from each terminal utilizing the application software, Image Express Utility Lite or MultiPresenter on the computer browser screen. Precise controls as changing number of screen portions and pages to display are available.
* This function is available when the “Managed” mode is selected for the [MultiPresenter] in the [NETWORK SETTINGS]. At the same time, the projector should be received and project images via the Image Express Utility Lite or MultiPresenter for utilizing this function.

PROJECTOR CONTROL
It enables to control the projector on the web browser screens on the computers.

HOW TO ACCESS THE WEB SERVER
Connect the projector and computers in a network and access the URL in below by the web browser of the computers.
URL: http://<IP address of the projector>

NETWORK SETTINGS
Set up below for connecting the projector with a wired/wireless LAN.

PROJECTOR NAME
Set up the projector name and host name. Serial number of the projector is set as factory default.

NETWORK INFORMATION
Indicate information when the projector has connected in a network (by a wired/wireless LAN)

WIRED LAN
Set up for connecting the projector by a wired LAN.

WIRELESS LAN
Set up for connecting the projector by a wireless LAN. At the same time, set up for the SIMPLE ACCESS POINT, Wi-Fi Direct, and Miracast.

MultiPresenter
Set up the MODE (FREE, MANAGED) for the MultiPresenter.

NETWORK SERVICE
Set up various setting for the AMX, HTTP server, PJLink, Alert mail and CRESTRON.
6. APPS MENU

TOOLS
Set up for various features as the mouse, program timer, day and time, administrator mode and default APP.

MOUSE
A commercially available USB mouse can be used for operating the APPS MENU. Perform the set up for using it.

PROGRAM TIMER
Once day and time is set up, changing the projector’s condition in powering ON/standby, switching input signals, and switching ECO mode can be automatically performed.

DATE AND TIME
Determine time zone and summer time of your area and set up current date and time.

ADMINISTRATOR MODE
Selecting the menu mode of the projector, enable/disable to save all set up values of the projector, and set up a password for the administrator mode.

DEFAULT APP
When a terminal other than the “APPS” terminal is selected and you switch to the “APPS” terminal, the function selected as the default application is launched automatically. When the projector is turned on in the condition of being selected the “APPS” terminal, the application selected in the [DEFAULT APP] will be started automatically.
## 7. User Supportware

### Software Included on CD-ROM

#### Names and Features of Bundled Software Programs

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
</table>
| Image Express Utility Lite | - This is a software program used to project your computer’s screen over the wired/wireless network. The computer cable (VGA) is not required. (→ page 93)  
- This software program can be used to control the power ON/OFF and source selection of the projector from your computer.  
- The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected on a curved wall. (→ page 98)  
- “GCT” function is not supported by Mac. |
| Image Express Utility Lite for Mac |     |

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC Control Utility Pro 4</td>
<td>This is a software program used to operate the projector from the computer when the computer and the projector are connected with LAN (wired or wireless) or a serial cable. (→ page 101)</td>
</tr>
<tr>
<td>PC Control Utility Pro 5 (for Mac OS)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
</table>
| Virtual Remote Tool (Windows only) | This is a software program used to control the power ON/OFF and source selection of the projector from your computer by using the supplied computer cable (VGA) and others. (→ page 106)  
Only via serial connection it is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing. |

**NOTE:**

- *Image Express Utility Lite does not support “Meeting Mode” in Image Express Utility 2.0 supplied with our other models.*

## Download Service and Operating Environment

Please visit our website about operating environment and download service for each software:


Download - Projector → Software & Driver
Projecting Your Computer’s Screen Image from the Projector over a LAN (Image Express Utility Lite)

Using Image Express Utility Lite contained on the supplied NEC Projector CD-ROM allows you to send the computer’s screen image to the projector over a wired or wireless LAN.

Image Express Utility Lite is a program compatible with Windows. Image Express Utility Lite for Mac is a program compatible with OS X. (→ page 97)

This section will show you an outline about how to connect the projector to a LAN and to use Image Express Utility Lite. For the operation of Image Express Utility Lite, see the help of Image Express Utility Lite.

Step 1: install Image Express Utility Lite on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start Image Express Utility Lite.

TIP:
- Image Express Utility Lite (for Windows) can be started from most commercially available removable media such as USB memory devices or SD cards without the need to install on your computer. (→ page 96)

What You can Do with Image Express Utility Lite

Image transmission (for Windows and OS X)
- The screen of your computer can be sent to the projector via a wired or wireless network without a computer cable (VGA).

Audio transfer capability (for Windows only)
- Image Express Utility Lite allows you to send the computer’s screen image and audio to the projector over wired/wireless LAN connection.
- Audio transfer capability is available only when the computer connects with the projector in peer-to-peer network.

Geometric Correction Tool [GCT] (for Windows only)
See “Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)”. (→ page 98)
Using on Windows

Step 1: install Image Express Utility Lite on the computer.

NOTE:
• To install or uninstall the program, the Windows user account must have “Administrator” privilege.
• Exit all running programs before installation. If another program is running, the installation may not be completed.
• Image Express Utility Lite will be installed to the system drive of your computer.
  If the message “There is not enough free space on destination” is displayed, free up enough space (about 100 MB) to install the program.

1. Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.
   The menu window will be displayed.

   TIP:
   If the menu window will not be displayed, try the following procedure.
   For Windows 7:
   1. Click “start” on Windows.
   2. Click “All Programs” → “Accessories” → “Run”.
   3. Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
   4. Click “OK”.
      The menu window will be displayed.

2. Click “Installing Image Express Utility Lite” on the menu window.
   The installation will start.
   “END USER LICENSE AGREEMENT” screen will be displayed.
   Read “END USER LICENSE AGREEMENT” carefully
3. If you agree, click “I agree.” and then click “Next”.
   • Follow the instructions on the installer screens to complete the installation.
   • When the installation is complete, you will return to the menu window.
   When the installation is complete, a completion message will be displayed.
4. Click “OK”.
   This completes the installation.

   TIP:
   • Uninstalling Image Express Utility Lite
   To uninstall Image Express Utility Lite, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote Tool” as “Image Express Utility Lite” (→ page 109)
Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 80) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 81).

Step 3: Start Image Express Utility Lite.
1. On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Image Express Utility Lite” → “Image Express Utility Lite”.
   Image Express Utility Lite will start.
   The select window for network connection will be displayed
2. Select Network and click “OK”.
   The select window for destination will show a list of connectable projectors.
   • When connecting the computer directly to the projector by one-to-one, “Simple Access Point” is recommended.
   • To check for the network available for connected projectors, from the menu, select [INFO.] → [WIRELESS LAN] → [SSID].
3. Place a check mark for projectors to be connected, and then click “Connect”.
   • When one or more projectors are displayed, from the menu on the projector, select [INFO.] → [WIRELESS LAN] → [IP ADDRESS].
   When connected to the projector, the Image Express Utility Lite control window appears at the top of the screen.
   The computer can be controlled by operating the control window.
4. Operate the control window.
   (1) (Streaming) ......This icon is not available on this projector.
   (2) (Source) ...........Selects an input source of the projector.
   (3) (Picture) ..........Turns on or off AV-MUTE (Picture mute), FREEZE (Freeze a picture), display, and GCT (geometric correction tool). Refer to page 98 about GCT.
   (4) (Sound) ..........Turns on or off AV-MUTE (Sound mute), play the sound and control the volume.
   (5) (Others) ..........Uses for “Update”, “HTTP Server”, “Settings” and “Information”.
   (6) (Project) ...........Enables to change screen size for presentation, menu indication (hide/indicate), interruption prohibition/accept interruption.
   It also enables to power off the projector.
   (7) (Help).................Displays the help of Image Express Utility Lite.

NOTE:
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector that is turned off will not be displayed in the select window for destination
TIP:

Viewing the “Help” file of Image Express Utility Lite

- **Displaying the Help file of Image Express Utility Lite while it is running.**
  
  Click the [?] (help) icon on the control window.
  
  The Help screen will be displayed.

- **Displaying the Help file of GCT while it is running.**
  
  Click “Help” → “Help” on the edit window.
  
  The Help screen will be displayed.

- **Displaying the help file using the Start Menu.**
  
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Image Express Utility Lite” → “Image Express Utility Lite Help”.
  
  The Help screen will be displayed.

Starting Image Express Utility Lite from a USB Memory or SD Card

Image Express Utility Lite can be started from commercially available removable media such as USB memory or SD cards if it is copied beforehand. This will eliminate the trouble of installing Image Express Utility Lite to your computer.

1. **Copy Image Express Utility Lite to removable media.**
   
   Copy all the folders and files (total size approx. 7 MB) from the “IEU_Lite (removable-media)” folder in the supplied NEC Projector CD-ROM to the root directory of your removable media.

2. **Insert your removable media into your computer.**
   
   The “AutoPlay” screen will be displayed on your computer.

   **TIP:**
   
   - If the “AutoPlay” screen is not displayed, open the folder from “Computer” (“My Computer” for Windows XP).

3. **Click “Open folder to view files”**
   
   The IEU_Lite.exe, other folder, and files will be displayed.

4. **Double-click the “IEU_Lite.exe” icon**
   
   Image Express Utility Lite will start.
Using on Mac

Step 1: Install Image Express Utility Lite for Mac on the computer
1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.
2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.
3. Double-click the “Mac OS X” folder.
4. Double-click “Image Express Utility Lite.dmg”.
   The “Image Express Utility Lite” window will be displayed.
5. Drag and drop the “Image Express Utility Lite” folder to your Applications folder on OS X.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 80) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 81).

Step 3: Start Image Express Utility Lite for Mac
1. Open your Applications folder on OS X.
2. Double-click the “Image Express Utility Lite” folder.
3. Double-click the “Image Express Utility Lite” icon.
   When Image Express Utility Lite for Mac starts, the select window for destination will be displayed.
   • At the first time of startup, “END USER LICENSE AGREEMENT” screen will be displayed before the select window for destination is displayed.
     Read “END USER LICENSE AGREEMENT” and select “I accept the terms in the license agreement”, and click “OK”.
4. Select a projector to be connected, and then click “Connect”.
   Your desktop screen will be displayed on the projector.

Tip:
Viewing the Help of Image Express Utility Lite for Mac
• From the menu bar, click “Help” → “Image Express Utility Lite Help” while Image Express Utility for Mac is running.
   The Help screen will be displayed

Uninstalling a software program
1. Put the “Image Express Utility Lite” folder to the Trash icon.
2. Put the configuration file of Image Express Utility Lite for Mac to the Trash icon.
   • The configuration file of Image Express Utility Lite for Mac is located in “/Users/<your user name>/Library/Preferences/jp.necds.Image_Express_Utility_Lite.plist”.
Projecting an Image from an Angle (GCT)

The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected even from an angle.

What you can do with GCT

- The GCT feature includes the following three functions:
  - **4-point Correction**: You can fit a projected image within the border of the screen easily by align the four corners of an image to the ones of the screen.
  - **Multi-point Correction**: You can correct a distorted image on the corner of a wall or irregular shaped screen by using many separated screens to correct the image as well as 4-point Correction.
  - **Parameters Correction**: You can correct a distorted image by using a combination of transformational rules prepared in advance.

This section will show an example for use with 4-point Correction.

For information about “Multi-point Correction” and “Parameters Correction”, see the help file of Image Express Utility Lite. (→ page 96, 97)

- Your correction data can be stored in the projector or your computer which can be restored when necessary.
- The GCT function is available with a wired or wireless LAN connection, and video cable.

**Projecting an Image from an Angle (GCT)**

Install Image Express Utility Lite on the computer and launch it to display the control window. (→ page 95)

Preparation: Adjust the projector position or the zoom so that the projected image can cover the whole screen area.

1. Click the “” (Others) icon and then the “” (Options) button.

   ![Options window](image)

   Options window will be displayed.

2. Click the check box “Use the multiple connection feature” and then clear the check mark.

   ![Options window](image)

3. Click the “OK” button.
4. Click the “Projection” icon and then the “Exit” button.

5. Click “Yes”.

6. Start the Image Express Utility Lite again.

7. Click the “Picture” icon and then the “GOT” button.

   The “4-point Correction” window will be displayed.

8. Click the “Start Correction” button and then “Start 4-point Correction” button.

   A green frame and a mouse pointer ( ) will be displayed.
   - Four [ ] marks will be appeared at four corners of the green frame

9. Use the mouse to click the [ ] mark of which corner you wish to move.

   The currently selected [ ] mark will turn red.

(In the above example, Windows screens are omitted for clarification.)
10. Drag the selected [● ] mark to the point you wish to correct and drop it.
   • When you click somewhere within the project image area, the nearest [● ] mark will go to the position where the mouse cursor is.

11. Repeat Step 9 and 10 to correct the distortion of the projected image.

12. After completing, right-click the mouse.
   The green frame and the mouse pointer will disappear from the projected image area. This will complete the correction.

13. Click the “X” (close) button on the “4-point Correction” window.
   The “4-point Correction” window will disappear and the 4-point correction will take effect.

14. Click the “ ” button on the control window to exit the GCT.

TIP:
• After performing the 4-point correction, you can save the 4-point correction data to the projector by clicking “File” → “Export to the projector…” on the “4-point Correction” window.
• See the Help of Image Express Utility Lite for operating “4-point Correction” window and other functions than GCT. (→ page 96, 97)
Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5)

Using the utility software “PC Control Utility Pro 4” and “PC Control Utility Pro 5” included on the companion NEC Projector CD-ROM, the projector can be controlled from a computer over a LAN.

PC Control Utility Pro 4 is a program compatible with Windows. (→ this page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 104)

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 103, 105)

Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start PC Control Utility Pro 4/Pro 5.

• To run PC Control Utility Pro 4 on Windows 8.1, Windows 8 and Windows XP, “Microsoft .NET Framework Version 2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install it on your computer.

TIP:
• With PC Control Utility Pro 4, control is also possible by RS-232C serial communications connected to the projector’s PC CONTROL terminal.

Using on Windows
Step 1: Install PC Control Utility Pro 4 on the computer

NOTE:
• To install or uninstall the program, the Windows user account must have [Administrator] privilege.
• Exit all running programs before installation. If another program is running, the installation may not be completed.

1 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

The menu window will be displayed.
7. User Supportware

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1. Click “start” on Windows.
2. Click “All Programs” → “Accessories” → “Run”.
3. Type your CD-ROM drive name (example: “Q:" ) and “LAUNCHER.EXE” in “Name”.
   (example: Q:\LAUNCHER.EXE)
4. Click “OK”. The menu window will be displayed.

2 Click “PC Control Utility Pro 4” on the menu window.
The installation will start.

![PC Control Utility Pro 4 installation screen]

When the installation is complete, the Welcome window will be displayed.

3 Click “Next”.
“END USER LICENSE AGREEMENT” screen will be displayed.

![END USER LICENSE AGREEMENT]

Read “END USER LICENSE AGREEMENT” carefully.

4 If you agree, click “I accept the terms in the license agreement” and then click “Next”.
   • Follow the instructions on the installer screens to complete the installation.
   • When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote Tool” as “PC Control Utility Pro 4” (→ page 109)
7. User Supportware

**Step 2: Connect the projector to a LAN.**
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 80) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 81).

**Step 3: Start PC Control Utility Pro 4**
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4”.

**NOTE:**
• For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the scheduler.

  [Example] For Windows 7:
  Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer to sleep” → “Never”.

  **NOTE:**
  • When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection.

**TIP:**

**Viewing the Help of PC Control Utility Pro 4**

• **Displaying the Help file of PC Control Utility Pro 4 while it is running.**
  Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.
  The pop-up menu will be displayed.

• **Displaying the help file using the Start Menu.**
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4 Help”.
  The Help screen will be displayed.
Using on Mac

Step 1: Install PC Control Utility Pro 5 on the computer
1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.
2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.
3. Double-click the “Mac OS X” folder.
4. Double-click “PC Control Utility Pro 5.pkg”.
   The installer will start.
5. Click “Next”.
   “END USER LICENSE AGREEMENT” screen will be displayed.
6. Read “END USER LICENSE AGREEMENT” and click “Next”.
   The confirmation window will be displayed
7. Click “I accept the terms in the license agreement”.
   Follow the instructions on the installer screens to complete the installation.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 80) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 81).

Step 3: Start PC Control Utility Pro 5
1. Open your Applications folder in OS X.
2. Click the “PC Control Utility Pro 5” folder.
3. Click the “PC Control Utility Pro 5” icon.
   PC Control Utility Pro 5 will start.

NOTE:
- For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.
- When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection.
Tip:

Uninstalling a software program
1. Put the “PC Control Utility Pro 5” folder to the Trash icon.
2. Put the configuration file of PC Control Utility Pro 5 to the Trash icon.
   • The configuration file of PC Control Utility Pro 5 is located in “/Users/<your user name>/Application Data/NEC Projector User Supportware/PC Control Utility Pro 5”.

Viewing the Help of PC Control Utility Pro 5
• Displaying the Help file of PC Control Utility Pro 5 while it is running.
  • From the menu bar, click “Help” → “Help” in this order.
    The Help screen will be displayed.
• Displaying the Help using the Dock
  1. Open “Application” folder in OS X.
  2. Click the “PC Control Utility Pro 5” folder.
  3. Click the “PC Control Utility Pro 5 Help” icon.
    The Help screen will be displayed.
Using the Computer Cable (VGA) to Operate the Projector (Virtual Remote Tool)

Using the utility software “Virtual Remote Tool” included on the companion NEC Projector CD-ROM, Virtual Remote screen (or toolbar) can be displayed on your computer screen. This will help you perform operations such as projector’s power on or off and signal selection via the computer cable (VGA), serial cable, or LAN connection. Only via serial connection it is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote control operation on your PC.

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 111)

Step 1: Install Virtual Remote Tool on the computer. (→ page 107)
Step 2: Connect the projector to the computer. (→ page 109)
Step 3: Start Virtual Remote Tool. (→ page 110)

TIP:
• Virtual Remote Tool can be used with a LAN and a serial connection. USB connection is not supported by Virtual Remote Tool.
• For update information on Virtual Remote Tool, visit our website:
NOTE:

• When [COMPUTER] is selected from your source selection, the Virtual Remote screen or the toolbar will be displayed as well as your computer screen.

• Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal directly with the monitor output terminal of the computer to use Virtual Remote Tool.

Using a switcher or other cables than the supplied computer cable (VGA) may cause failure in signal communication.

VGA cable terminal:
Pin Nos. 12 and 15 are required for DDC/CI.

• Virtual Remote Tool may not work depending on your computer’s specifications and version of graphic adapters or drivers.

• To run Virtual Remote Tool on Windows 8.1 and Windows 8, “Microsoft .NET Framework Version 2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install it on your computer.

• Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:

  (Only via serial connection)
  - File size: Less than 768 KB
  - Image size (resolution):
    P502HL-2: Horizontal 1920 × vertical 1080 dots or less
    P502WL-2: Horizontal 1280 × vertical 800 dots or less

• To put the default “NEC logo” back in the background logo, you need to register it as the background logo by using the image file (P502HL-2:/Logo/NEC_logo2015_1920x1080.bmp, P502WL-2:/Logo/NEC_logo2015_1280x800.bmp) included on the supplied NEC Projector CD-ROM.

TIP:

• The projector’s COMPUTER IN terminal supports DDC/CI (Display Data Channel Command Interface). DDC/CI is a standard interface for bidirectional communication between display/projector and computer.

• With the Virtual Remote Tool, control is possible with both network (wired/wireless LAN) and serial connections.

Step 1: Install Virtual Remote Tool on the computer

NOTE:

• To install Virtual Remote Tool, the Windows user account must have “Administrator” privilege.

• Exit all running programs before installing Virtual Remote Tool. If another program is running, the installation may not be completed.

1 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

The menu window will be displayed.

TIP:

If the menu window will not be displayed, try the following procedure.

For Windows 7
1. Click “start” on Windows.
2. Click “All Programs” → “Accessories” → “Run”.
3. Type your CD-ROM drive name (example: “Q:”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
4. Click “OK”.

The menu window will be displayed.
2  **Click “Install Virtual Remote Tool” on the menu window.**
The installation will start.

![Image of Install Virtual Remote Tool]

When the installation is complete, the Welcome window will be displayed.

3  **Click “Next”.**

“END USER LICENSE AGREEMENT” screen will be displayed.

![Image of End User License Agreement]

Read “END USER LICENSE AGREEMENT” carefully.

4  **If you agree, click “I accept the terms in the license agreement” and then click “Next”.**

- Follow the instructions on the installer screens to complete the installation.
- When the installation is complete, you will return to the menu window.
**Uninstalling Virtual Remote Tool**

**Preparation:**
Exit Virtual Remote Tool before uninstalling. To uninstall Virtual Remote Tool, the Windows user account must have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7 and Windows Vista) or “Computer Administrator” privilege (Windows XP).

- **For Windows 8.1, Windows 8, Windows 7 and Windows Vista**
  1. **Click “Start” and then “Control Panel”**.
     - The Control Panel window will be displayed.
  2. **Click “Uninstall a program” under “Programs”**
     - The “Programs and Features” window will be displayed.
  3. **Select Virtual Remote Tool and click it.**
  4. **Click “Uninstall/Change” or “Uninstall”**.
     - When the “User Account Control” windows is displayed, click “Continue”.
     - Follow the instructions on the screens to complete the uninstallation.

---

**Step 2: Connect the projector to the computer**

1. **Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal of the projector directly with the monitor output terminal of the computer.**

2. **Connect the supplied power cord to the AC IN of the projector and the wall outlet.**
   - The projector is in the standby condition.

---

**TIP:**
- When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed to navigate your connections.
7. User Supportware

Step 3: Start Virtual Remote Tool

Start using the shortcut icon

- Double-click the shortcut icon on the Windows Desktop.

![Shortcut Icon]

Start from the Start menu

- Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] → [Virtual Remote Tool].

When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

![Virtual Remote Tool](easy_setup_window)

Follow the instructions on the screens

When “Easy Setup” is completed, the Virtual Remote Tool screen will be displayed.

![Virtual Remote Tool Screen]

NOTE:

- When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the computer cable (VGA) or network (wired LAN/wireless LAN) connection.

TIP:

- The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window. To do so, click to place a check mark for “Do not use Easy Setup next time” on the screen at Step 6 in “Easy Setup”.

![Virtual Remote Tool Toolbar]
7. User Supportware

Exiting Virtual Remote Tool

1. Click the Virtual Remote Tool icon on the Taskbar.
   The pop-up menu will be displayed.

2. Click “Exit”.
   The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool

• Displaying the help file using the taskbar

1. Click the Virtual Remote Tool icon on the taskbar when Virtual Remote Tool is running.
   The pop-up menu will be displayed.

2. Click “Help”.
   The Help screen will be displayed.

• Displaying the help file using the Start Menu.

1. Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Virtual Remote Tool” and then “Virtual Remote Tool Help” in this order.
   The Help screen will be displayed.
Introduction of MultiPresenter application

This projector is compatible with the NEC MultiPresenter application (hereafter referred to simply as “MultiPresenter”).

- MultiPresenter is compatible with multiple OSes (Windows, OS X, Android and iOS), so it can be started up on multiple computers or smartphones, images and documents* can be transferred over the network (wired LAN/ wireless LAN) and multi-screen projection can be performed from this projector.

On this projector, select the APPS menu → “MultiPresenter”. (→ page 88)

* The screen images and audio (audio can be transmitted only when using Windows) on your computer. The files and photos, camera images, WEB pages on inside an Android terminal, iPhone or iPad.

MultiPresenter can be used in an existing network environment.

Connection Example

For details on MultiPresenter, please visit the MultiPresenter website.

8. Maintenance

1 Cleaning the Lens

- Turn off the projector before cleaning.
- The projector has a plastic lens. Use a commercially available plastic lens cleaner.
- Do not scratch or mar the lens surface as a plastic lens is easily scratched.
- Never use alcohol or glass lens cleaner as doing so will cause damage to the plastic lens surface.

**WARNING**
- Do not use a spray containing flammable gas to remove dust attached to the lens, etc. Doing so may result in fire.
Cleaning the Cabinet

Turn off the projector, and unplug the projector before cleaning.

- Use a dry soft cloth to wipe dust off the cabinet.
  
  If heavily soiled, use a mild detergent.

- Never use strong detergents or solvents such as alcohol or thinner.

- When cleaning the ventilation slits or the speaker using a vacuum cleaner, do not force the brush of the vacuum cleaner into the slits of the cabinet.

![Vacuum the dust off the ventilation slits or the speaker.](image)

- Poor ventilation caused by dust accumulation in ventilation openings can result in overheating and malfunction. These areas should be cleaned regularly.

- Do not scratch or hit the cabinet with your fingers or any hard objects

- Contact your dealer for cleaning the inside of the projector.

**NOTE:** Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off.
# 9. Appendix

## Troubleshooting

This section helps you resolve problems you may encounter while setting up or using the projector.

### Indicator Messages

#### POWER Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The main power is off</td>
<td></td>
</tr>
<tr>
<td>Blinking light Blue</td>
<td>0.5 sec On, 0.5 sec Off</td>
<td>The projector is getting ready to turn on. Wait for a moment.</td>
</tr>
<tr>
<td>Orange (short flashes)</td>
<td>Off Timer is enabled. Program timer (off time enabled)</td>
<td></td>
</tr>
<tr>
<td>Orange (long flashes)</td>
<td>Program timer (on time enabled)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady light Blue</td>
<td>The projector is turned on.</td>
<td></td>
</tr>
<tr>
<td>Orange</td>
<td>In Standby condition [NETWORK STANDBY] is selected for [STANDBY MODE]</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>In Standby condition [NORMAL] is selected for [STANDBY MODE]</td>
<td></td>
</tr>
</tbody>
</table>

#### STATUS Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Normal or Standby</td>
<td></td>
</tr>
<tr>
<td>Blinking light Red</td>
<td>2 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Temperature error</td>
</tr>
<tr>
<td></td>
<td>3 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Power error</td>
</tr>
<tr>
<td></td>
<td>4 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Fan error</td>
</tr>
<tr>
<td></td>
<td>6 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Light source error</td>
</tr>
<tr>
<td>Orange</td>
<td>1 cycle (0.5 sec On, 2.5 sec Off)</td>
<td>Network conflict</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady light Green</td>
<td>Sleep mode*</td>
<td></td>
</tr>
<tr>
<td>Orange</td>
<td>CONTROL PANEL LOCK is on.</td>
<td>You have pressed cabinet button when Control Panel Lock is on.</td>
</tr>
<tr>
<td></td>
<td>CONTROL ID error</td>
<td>Remote control ID and projector ID are not matched.</td>
</tr>
</tbody>
</table>

* The sleep mode refers to the mode in which the restrictions to functions due to the [STANDBY MODE] settings have been eliminated.

#### LIGHT Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No trouble or [ECO MODE] is set to [OFF].</td>
<td></td>
</tr>
<tr>
<td>Steady light Green</td>
<td>[ECO MODE] is set to [ECO1] or [ECO2]</td>
<td></td>
</tr>
</tbody>
</table>

*The sleep mode refers to the mode in which the restrictions to functions due to the [STANDBY MODE] settings have been eliminated.*
Over-Temperature Protection
If the projector inside temperature gets too high, the light modules will be turned off automatically and the status indicator will start to blink (2-cycle On and OFF).
Should this happen, do the following:
• Unplug the power cord after the cooling fans stop.
• Move the projector to a cooler location if the room where you are presenting is particularly too warm.
• Clean the vents if they are clogged with dust.
• Wait about 60 minutes until the inside of the projector becomes cool enough.
### Common Problems & Solutions

(→ “POWER/STATUS/LIGHT Indicator” on page 115.)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Does not turn on or shut down | • Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control is on. (→ pages 11, 12)  
• Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room where you are presenting is particularly warm, move the projector to a cooler location.  
• The light module may fail to light. Wait a full minute and then turn on the power again.  
• Set [FAN MODE] to [HIGH] when using the projector at altitudes approximately 5500 feet/1700 meters or higher. Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and turn on the projector. (→ page 58)  
If you turn on the projector immediately after the light module is turned off, the fans run without displaying an image for some time and then the projector will display the image. Wait for a moment.  
• In case it's hard to think the trouble is not caused on the above mentioned conditions, unplug the power cord from the outlet. Then wait 5 minutes before plugging it in again. (→ page 24) |
| Will turn off | • Ensure that the [OFF TIMER] or [AUTO POWER OFF] is off. (→ page 52, 61) |
| No picture | • Check if the appropriate input is selected. (→ page 14) If there is still no picture, press the SOURCE button or one of the source buttons again.  
• Ensure your cables are connected properly.  
• Use menus to adjust the brightness and contrast. (→ page 45)  
• Check that the AV MUTE (image off) buttons are not pressed.  
• Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 66)  
• Enter your registered keyword if the Security function is enabled. (→ page 30)  
• If the HDMI 1 IN or the HDMI 2 IN signal cannot be displayed, try the following.  
- Reinstall your driver for the graphics card built in your computer, or use the updated driver.  
  For reinstalling or updating your driver, refer to the user guide accompanied with your computer or graphics card, or contact the support center for your computer manufacturer.  
- Install the updated driver or OS on your own responsibility.  
  We are not liable for any trouble and failure caused by this installation.  
• Signals may not be supported depending on the HDBaseT transmission device. IR and RS232C cannot be used in certain cases as well.  
• Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.  
In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  
* If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power management software.  
• See also the next page. |
| Picture suddenly becomes dark | • Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 58) |
| Color tone or hue is unusual | • Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 51)  
• Adjust [HUE] in [PICTURE]. (→ page 45) |
| Image isn’t square to the screen | • Reposition the projector to improve its angle to the screen. (→ page 16)  
• Use the Keystone correction function to correct the trapezoid distortion. (→ page 21) |
| Picture is blurred | • Adjust the focus. (→ page 19)  
• Reposition the projector to improve its angle to the screen. (→ page 16)  
• Ensure that the distance between the projector and screen is within the adjustment range of the lens. (→ page 67)  
• Has the lens been shifted by an amount exceeding the guaranteed range? (→ page 71)  
• Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. Should this happen, let the projector stand until there is no condensation on the lens. |
| Image is scrolling vertically, horizontally or both | • Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported by the projector. (→ page 126)  
• Adjust the computer image manually with the [HORIZONTAL]/[VERTICAL] in the [IMAGE OPTIONS]. (→ page 47) |
### Problem | Check These Items
--- | ---
Remote control does not work | • Install new batteries. (→ page 9)<br>• Make sure there are no obstacles between you and the projector.<br>• Stand within 22 feet (7 m) of the projector. (→ page 9)<br>• The remote control sensor on the back of the projector cannot be used when the cable cover is mounted on the projector.
Indicator is lit or blinking | • See the POWER/STATUS/LIGHT Indicator. (→ page 115)
Cross color in RGB mode | • Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 23)<br>• Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 46)

For more information contact your dealer.

### If there is no picture, or the picture is not displayed correctly.

- **Power on process for the projector and the PC.**
  Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.
  In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.

  **NOTE:** You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, this means there is no signal being output from the computer. (→ page 65 or go to next step)

- **Enabling the computer’s external display.**
  Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

- **Non-standard signal output from the computer**
  If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. Refer to your computer’s documentation for detailed information.

- **Image displayed is incorrect when using a Mac**
  When using a Mac with the projector, set the DIP switch of the Mac adapter (not supplied with the projector) according to your resolution. After setting, restart your Mac for the changes to take affect.
  For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to the 13" fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then restart the Mac again.

  **NOTE:** A Video Adapter cable manufactured by Apple Inc. is needed for a MacBook which does not have a mini D-Sub 15-pin terminal.

- **Mirroring on a MacBook**
  * When using the projector with a MacBook, output may not be set to 1024 × 768 unless “mirroring” is off on your MacBook. Refer to owner’s manual supplied with your Mac computer for mirroring.

- **Folders or icons are hidden on the Mac screen**
  Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple menu and arrange icons.
# Specifications

This section provides technical information about projector's performance.

<table>
<thead>
<tr>
<th>Model name</th>
<th>NP-P502HL-2</th>
<th>NP-P502WL-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>1 Chip DLP type</td>
<td></td>
</tr>
<tr>
<td>Specifications of main parts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DMD panel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>0.65” (aspect ratio: 16:9)</td>
<td>0.65” (aspect ratio: 16:10)</td>
</tr>
<tr>
<td>Pixels (1)</td>
<td>2,073,600 (1920 dots x 1080 lines)</td>
<td>1,024,000 (1280 dots x 800 lines)</td>
</tr>
<tr>
<td>Projection lenses</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>2.0, 1 = 18.2–31.1 mm</td>
<td></td>
</tr>
<tr>
<td>Focus</td>
<td>Manual (Zoom Ratio = 1.7)</td>
<td></td>
</tr>
<tr>
<td>Lens shifting</td>
<td>H: ±25% , V: +62%, –0%</td>
<td>H: ±28%, V: ±59%, –0%</td>
</tr>
<tr>
<td>Light source</td>
<td>Blue Laser Diode</td>
<td></td>
</tr>
<tr>
<td>Optical device</td>
<td>Optical isolation by dichroic mirror, combining by dichroic prism</td>
<td></td>
</tr>
<tr>
<td>Light output (2) (3)</td>
<td>5,000 lm</td>
<td></td>
</tr>
<tr>
<td>Contrast ratio (2) (all white/all black)</td>
<td>20,000:1 with dynamic contrast</td>
<td></td>
</tr>
<tr>
<td>Screen size (throw distance)</td>
<td>30 to 300 inches (0.8–14.2 m)</td>
<td></td>
</tr>
<tr>
<td>Projection Angle</td>
<td>From 0 to 15.9 deg at 80”</td>
<td>From 0 to 14.8 deg at 80”</td>
</tr>
<tr>
<td>Projection Distance (From Projection Lens)</td>
<td>Wide: From 0.8 to 8.2 m</td>
<td>Wide: From 0.8 to 8.4 m</td>
</tr>
<tr>
<td></td>
<td>Tele: From 1.4 to 14.2 m</td>
<td>Tele: From 1.4 to 14.5 m</td>
</tr>
<tr>
<td>Color reproducibility</td>
<td>10-bit color processing (approx. 1.07 billion colors)</td>
<td></td>
</tr>
<tr>
<td>Scanning frequency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td>Analog: 15 kHz, 24 to 100 kHz (24 kHz or greater for RGB inputs), conforming to VESA standards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Digital: 15 kHz, 24 to 153 kHz, conforming to VESA standards</td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td>Analog: 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Digital: 24, 25, 30, 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards</td>
<td></td>
</tr>
<tr>
<td>Main adjustment functions</td>
<td>Manual zoom, manual focus, manual lens shift, input signal switching (HDMI1/HDMI2/COMPUTER/VIDEO/HDBaseT), auto image adjustment, picture magnification, muting (video), power on/standby, on-screen display/selection, etc.</td>
<td></td>
</tr>
<tr>
<td>Max. display resolution (horizontal x vertical)</td>
<td>Analog: 1920 x 1200 (handled with Advanced AccuBlend)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Digital: 1920 x 1080 (handled with Advanced AccuBlend)</td>
<td></td>
</tr>
<tr>
<td>Input signals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R,G,B,H,V</td>
<td>RGB: 0.7 Vp-p/75 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y: 1.0 Vp-p/75 Ω (with Negative Polarity Sync)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cb, Cr (Pb, Pr): 0.7 Vp-p/75 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td>H/V Sync: 4.0 Vp-p/TTL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Composite Sync: 4.0 Vp-p/TTL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sync on G: 1.0 Vp-p/75 Ω (with Sync)</td>
<td></td>
</tr>
<tr>
<td>Composite video</td>
<td>1.0 Vp-p/75 Ω</td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Y: 1.0 Vp-p/75 Ω (with Sync)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cb, Cr (Pb, Pr): 0.7 Vp-p/75 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DTV: 480i, 480p, 720p, 1080i, 1080p (60 Hz)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>576i, 576p, 720p, 1080i, 1080p (50 Hz)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DVD: Progressive signal (50/60 Hz)</td>
<td></td>
</tr>
<tr>
<td>Audio</td>
<td>Stereo L/R: 0.5 Vrms/22 kΩ or over</td>
<td></td>
</tr>
<tr>
<td>Input/output terminals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer/Component</td>
<td>Video input</td>
<td>Mini D-Sub 15-pin x 1</td>
</tr>
<tr>
<td></td>
<td>Video output</td>
<td>Mini D-Sub 15-pin x 1</td>
</tr>
<tr>
<td></td>
<td>Audio input</td>
<td>RCA x 2 (For Video), Stereo mini Jack (For Computer)</td>
</tr>
<tr>
<td></td>
<td>Audio output</td>
<td>Stereo mini Jack (Selected from: Computer/Video/HDMI)</td>
</tr>
<tr>
<td>HDMI</td>
<td>Video input</td>
<td>HDMI® Terminal type A x 2</td>
</tr>
<tr>
<td></td>
<td>Deep Color (color depth): 8/10/-12-bit compatible</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Colorimetry: RGB, YcbCr444 and YcbCr422 compatible</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LipSync compatible, HDCP compatible (*) (Supports 3D)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audio input</td>
<td>HDMI: Sampling frequency – 32/44.1/48 kHz, Sampling bits – 16/20/24 bits</td>
</tr>
<tr>
<td>HDBaseT</td>
<td>Video input</td>
<td>Deep Color (color depth): Support 8/10/12 bits</td>
</tr>
<tr>
<td></td>
<td>Colorimetry: Support RGB, YCbCr444 and YCbCr422</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Support LipSync, HDCP (**), 3D</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audio input</td>
<td>Sampling frequency: 32/44.1/48 kHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sampling bit: 16/20/24 bit</td>
</tr>
<tr>
<td>USB port</td>
<td>USB type A x 1 (For USB Memory)</td>
<td></td>
</tr>
<tr>
<td>Ethernet/HDBaseT port</td>
<td>RJ-45 x 1, Supports BASE-TX</td>
<td></td>
</tr>
<tr>
<td>3D SYNC output terminal</td>
<td>5 V / 10 mA, synchronized signal output for 3D use</td>
<td></td>
</tr>
<tr>
<td>Control Terminals</td>
<td>RS-232C terminal (PC control)</td>
<td>D-Sub 9-pin x 1</td>
</tr>
<tr>
<td>Built-in Speaker</td>
<td>20 W (monaural)</td>
<td></td>
</tr>
</tbody>
</table>
## 9. Appendix

<table>
<thead>
<tr>
<th>Model name</th>
<th>NP-P502HL-2</th>
<th>NP-P502WL-2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Usage environment</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating temperature:</td>
<td>5 to 40°C</td>
<td></td>
</tr>
<tr>
<td>(°C) (5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating humidity:</td>
<td>20 to 80%</td>
<td></td>
</tr>
<tr>
<td>(with no condensation)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage temperature:</td>
<td>–10 to 50°C</td>
<td></td>
</tr>
<tr>
<td>(°C) (5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage humidity:</td>
<td>20 to 80%</td>
<td></td>
</tr>
<tr>
<td>(with no condensation)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating altitude:</td>
<td>0 to 2600 m</td>
<td></td>
</tr>
<tr>
<td>(8500 feet)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Set [FAN MODE] to [HIGH]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>when using the projector</td>
<td></td>
<td></td>
</tr>
<tr>
<td>at altitudes approximately</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5500 feet/1700 meters or</td>
<td></td>
<td></td>
</tr>
<tr>
<td>higher.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power supply</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100–240 V AC, 50/60 Hz</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power consumption</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ECO MODE OFF</td>
<td>464 W (100-130 V)</td>
<td>442 W (200-240 V)</td>
</tr>
<tr>
<td>ON</td>
<td>362 W (100-130 V)</td>
<td>347 W (200-240 V)</td>
</tr>
<tr>
<td>STANDBY MODE NORMAL</td>
<td>0.15 W (100-130 V)</td>
<td>0.36 W (200-240 V)</td>
</tr>
<tr>
<td>STANDBY MODE NETWORK</td>
<td>2.1 W (100-130 V)</td>
<td>2.3 W (200-240 V)</td>
</tr>
<tr>
<td><strong>Rated input current</strong></td>
<td>2.3 A (240 V AC)</td>
<td>5.7A (100 V AC)</td>
</tr>
<tr>
<td><strong>External dimensions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18.46” (width) × 5.39” (height) × 14.37” (depth)/</td>
<td></td>
<td></td>
</tr>
<tr>
<td>469 (width) × 137 (height) × 365 (depth) mm (not including protrusions)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18.46” (width) × 6.18” (height) × 14.57” (depth)/</td>
<td></td>
<td></td>
</tr>
<tr>
<td>469 (width) × 157 (height) × 370 (depth) mm (including protrusions)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>19.18 lbs (8.7 kg)</td>
<td></td>
</tr>
</tbody>
</table>

*1 Effective pixels are more than 99.99%.
*2 Compliance with ISO21118-2012
*3 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the [PRESET] mode, the light output value may drop slightly.
*4 HDMI® (Deep Color, Lip Sync) with HDCP

What is HDCP/HDCP technology?

HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI).

If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

Video: Deep Color; 8/10/12-bit, LipSync

Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit; 16/20/24-bit

*5 35 to 40°C – “Forced eco mode”

- These specifications and the product's design are subject to change without notice.

For additional information visit:

US: http://www.necdisplay.com/

Europe: http://www.nec-display-solutions.com/


For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.
Cabinet Dimensions

Unit: mm (inch)
Attaching the Optional Cable Cover (NP08CV)

After finishing connections, attach the supplied cable cover to properly hide the cables.

**CAUTION:**
- Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come off and fall, resulting in injury or damage to the cable cover.
- Do not put bundled cables in the cable cover. Doing so may damage the power cord, resulting in a fire.
- Do not hold the cable cover while moving the projector or do not apply excessive force to the cable cover. Doing so may damage the cable cover, resulting in injury.

**Attaching the cable cover**

**Tool needed:**
- Phillips screwdriver (plus-head) about 9 cm/4 inches in length

1. **Align two claws on the cable cover edge with grooves of the projector and push the top end.**
   - The remaining claw on the cable cover also goes in the projector’s groove.

**NOTE:**
- Be careful not to get cables caught in between the cable cover and the projector.

2. **Tighten the cable cover screws.**
   - Be sure to tighten the screws.
Removing the cable cover

1. Loosen the cable cover screws until the Phillips screwdriver goes into a freewheeling condition.
   - When suspended from the ceiling, hold so that the cable cover does not drop.
   - The screws cannot be removed.

2. Remove the cable cover.
   (1) Rotate a little downwards so that the claw comes out of the projector’s groove.
   (2) Slide downwards so that the claw on the cover edge comes out of the projector’s groove.
9. Appendix

Pin assignments and signal names of main terminals

COMPUTER IN Terminal (Mini D-Sub 15 Pin)

Connection and signal level of each pin

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>RGB Signal (Analog)</th>
<th>YCbCr Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>Cr</td>
</tr>
<tr>
<td>2</td>
<td>Green or Sync on Green</td>
<td>Y</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>Cb</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Red Ground</td>
<td>Cr Ground</td>
</tr>
<tr>
<td>7</td>
<td>Green Ground</td>
<td>Y Ground</td>
</tr>
<tr>
<td>8</td>
<td>Blue Ground</td>
<td>Cb Ground</td>
</tr>
<tr>
<td>9</td>
<td>Hot Plug</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sync Signal Ground</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Bi-directional DATA (SDA)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Horizontal Sync or Composite Sync</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Vertical Sync</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Data Clock</td>
<td></td>
</tr>
</tbody>
</table>

Signal Level

Video signal: 0.7Vp-p (Analog)
Sync signal: TTL level

HDMI 1 IN/HDMI 2 IN Terminal (Type A)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TMDS Data 2+</td>
<td>11</td>
<td>TMDS Clock Shield</td>
</tr>
<tr>
<td>2</td>
<td>TMDS Data 2 Shield</td>
<td>12</td>
<td>TMDS Clock–</td>
</tr>
<tr>
<td>3</td>
<td>TMDS Data 2–</td>
<td>13</td>
<td>CEC</td>
</tr>
<tr>
<td>4</td>
<td>TMDS Data 1+</td>
<td>14</td>
<td>Disconnection</td>
</tr>
<tr>
<td>5</td>
<td>TMDS Data 1 Shield</td>
<td>15</td>
<td>SCL</td>
</tr>
<tr>
<td>6</td>
<td>TMDS Data 1–</td>
<td>16</td>
<td>SDA</td>
</tr>
<tr>
<td>7</td>
<td>TMDS Data 0+</td>
<td>17</td>
<td>DDC/CEC grounding</td>
</tr>
<tr>
<td>8</td>
<td>TMDS Data 0 Shield</td>
<td>18</td>
<td>+5 V power supply</td>
</tr>
<tr>
<td>9</td>
<td>TMDS Data 0–</td>
<td>19</td>
<td>Hot plug detection</td>
</tr>
<tr>
<td>10</td>
<td>TMDS Clock +</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

124
Ethernet/HDBaseT/LAN Port (RJ-45)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxD+/HDBT0+</td>
</tr>
<tr>
<td>2</td>
<td>TxD-/HDBT0–</td>
</tr>
<tr>
<td>3</td>
<td>RxD+/HDBT1+</td>
</tr>
<tr>
<td>4</td>
<td>Disconnection/HDBT2+</td>
</tr>
<tr>
<td>5</td>
<td>Disconnection/HDBT2–</td>
</tr>
<tr>
<td>6</td>
<td>RxD–/HDBT1–</td>
</tr>
<tr>
<td>7</td>
<td>Disconnection/HDBT3+</td>
</tr>
<tr>
<td>8</td>
<td>Disconnection/HDBT3–</td>
</tr>
</tbody>
</table>

USB Port (Type A)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>V_BUS</td>
</tr>
<tr>
<td>2</td>
<td>D–</td>
</tr>
<tr>
<td>3</td>
<td>D+</td>
</tr>
<tr>
<td>4</td>
<td>Grounding</td>
</tr>
</tbody>
</table>

PC CONTROL Port (D-Sub 9 Pin)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unused</td>
</tr>
<tr>
<td>2</td>
<td>RxD reception data</td>
</tr>
<tr>
<td>3</td>
<td>TxD transmission data</td>
</tr>
<tr>
<td>4</td>
<td>Unused</td>
</tr>
<tr>
<td>5</td>
<td>Grounding</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
</tr>
<tr>
<td>7</td>
<td>RTS transmission request</td>
</tr>
<tr>
<td>8</td>
<td>CTS transmission allowed</td>
</tr>
<tr>
<td>9</td>
<td>Unused</td>
</tr>
</tbody>
</table>

Communications protocol
### Compatible Input Signal List

#### Analog RGB

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4:3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4:3</td>
<td>56/60/72/75/85/iMac</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768 *1</td>
<td>4:3</td>
<td>60/70/75/85/iMac</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768 *2</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280 × 800 *2</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1360 × 768 *2</td>
<td>16:9 *3</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366 × 768 *2</td>
<td>16:9 *3</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4:3</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5:4</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900 *2</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1920 × 1200</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>MAC 13*</td>
<td>640 × 480</td>
<td>4:3</td>
<td>67</td>
</tr>
<tr>
<td>MAC 16*</td>
<td>832 × 624</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 19*</td>
<td>1024 × 768</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21*</td>
<td>1152 × 870</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23*</td>
<td>1280 × 1024</td>
<td>5:4</td>
<td>65</td>
</tr>
</tbody>
</table>

#### Component

<table>
<thead>
<tr>
<th>Signal</th>
<th>Format</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDTV (1080p)</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280 × 720</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>720 × 480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576p)</td>
<td>720 × 576</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i)</td>
<td>720 × 576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

#### Composite Video

<table>
<thead>
<tr>
<th>Signal</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>PAL</td>
<td>4:3</td>
<td>50</td>
</tr>
<tr>
<td>PAL60</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SECAM</td>
<td>4:3</td>
<td>50</td>
</tr>
</tbody>
</table>

#### HDMI

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768 *2</td>
<td>15:9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280 × 800 *2</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366 × 768 *2</td>
<td>16:9 *3</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5:4</td>
<td>60</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900 *2</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1920 × 1200</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>MAC 13*</td>
<td>640 × 480</td>
<td>4:3</td>
<td>67</td>
</tr>
<tr>
<td>MAC 16*</td>
<td>832 × 624</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 19*</td>
<td>1024 × 768</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21*</td>
<td>1152 × 870</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23*</td>
<td>1280 × 1024</td>
<td>5:4</td>
<td>65</td>
</tr>
</tbody>
</table>

#### 3D

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4:3</td>
<td>60/120*6</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16:9</td>
<td>60/120*6</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 800</td>
<td>16:10</td>
<td>60/120*6</td>
</tr>
<tr>
<td>HDTV (1080p)</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>60/120*6</td>
</tr>
</tbody>
</table>

#### HDMI 3D

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080p</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>23.98/24</td>
</tr>
<tr>
<td>720p</td>
<td>1280 × 720</td>
<td>16:9</td>
<td>50/59.94/60</td>
</tr>
<tr>
<td>1080i</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>50/59.94/60</td>
</tr>
<tr>
<td>1080p</td>
<td>1920 × 1080</td>
<td>16:9</td>
<td>23.98/24</td>
</tr>
<tr>
<td>720p</td>
<td>1280 × 720</td>
<td>16:9</td>
<td>50/59.94/60</td>
</tr>
</tbody>
</table>

*1 Native resolution on WXGA model (P502WL-2)

*2 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].

*3 WXGA MODE: OFF

*4 Native resolution on 1080p model (P502HL-2)

*5 WXGA MODE: ON

*6 120Hz signals are supported for Frame Sequential only.

**NOTE:**

- An image with higher or lower resolution than the projector’s native resolution (1280 × 800) will be displayed with Advanced AccuBlend.
- Sync on Green and Composite sync signals are not supported.
- Signals other than those specified in the table above may not be displayed correctly. If this should happen, change the refresh rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.
# PC Control Codes and Cable Connection

## PC Control Codes

<table>
<thead>
<tr>
<th>Function</th>
<th>Code Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER ON</td>
<td>02H 00H 00H 00H 02H</td>
</tr>
<tr>
<td>POWER OFF</td>
<td>02H 01H 00H 00H 03H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI1</td>
<td>02H 03H 00H 00H 02H 01H A1H A9H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI2</td>
<td>02H 03H 00H 00H 02H 01H A2H AAH</td>
</tr>
<tr>
<td>INPUT SELECT VIDEO</td>
<td>02H 03H 00H 00H 02H 01H 06H 0E0H</td>
</tr>
<tr>
<td>INPUT SELECT APPS</td>
<td>02H 03H 00H 00H 02H 01H 23H 28H</td>
</tr>
<tr>
<td>INPUT SELECT HDBaseT</td>
<td>02H 03H 00H 00H 02H 01H BFH C7H</td>
</tr>
<tr>
<td>PICTURE MUTE ON</td>
<td>02H 10H 00H 00H 00H 12H</td>
</tr>
<tr>
<td>PICTURE MUTE OFF</td>
<td>02H 11H 00H 00H 00H 13H</td>
</tr>
<tr>
<td>SOUND MUTE ON</td>
<td>02H 12H 00H 00H 00H 14H</td>
</tr>
<tr>
<td>SOUND MUTE OFF</td>
<td>02H 13H 00H 00H 00H 15H</td>
</tr>
</tbody>
</table>

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

## Cable Connection

**Communication Protocol**

- Baud rate: 38400 bps
- Data length: 8 bits
- Parity: No parity
- Stop bit: One bit
- X on/off: None
- Communications procedure: Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

## PC Control Terminal (D-SUB 9P)

![PC Control Terminal Diagram]

NOTE 1: Pins 1, 4, 6 and 9 are not used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.
Update the Software

Using the web browser on a computer, download the updated software for the projector from our web site and install it on the projector by the wired LAN connection.

NOTE:
- The exclusive web browser enables to update the software is Internet Explorer 11.
- Before performing the software update, make sure to connect your computer with the projector by the LAN cable. It does not support the wireless LAN connection.
- Make sure to set [NETWORK STANDBY] as the standby mode of the projector. Factory default setting for the standby mode is [NORMAL] (→ page 60)
- The software update is enabled only when the projector is in standby condition. While performing the software update, do not power on the projector. At the same time, do not shut down the AC power.
- Never update the browser page during the software update. It disables the computer for displaying the web page correctly.

1. Access to the software download support page in our web site.

2. Check if the software installed on the projector in use is updated.
   • You can check the software version from either [VERSION(1)] or [VERSION(2)] in the onscreen menu [INFORMATION].

3. If newer software version than one on the projector in use is uploaded on our website, download and save it in an appropriate folder on your computer.

4. Turn off the power of the projector and set it in the standby condition.

   Important:
   • Software update cannot be performed when the standby mode is set at NORMAL.

5. Connect the projector with your computer by the LAN cable.

6. Start up the web browser on your computer and then input the following web address:
   URL (for the software update): http://<Projector IP address>/update.html
   The software update screen will be displayed on.

7. Click [Browse….] at the center of the screen and select the software you saved in the procedure 3.
   • Check the file name indicated on the UPDATE FILE list.

8. Click [START UPDATING] at the center of the screen.
   The screen display will change and your computer starts to update the software.
NOTE:
- During the software update, pay attention to the follows:
  - Do not turn off the AC Power for the projector.
  - Do not reload or move the web page.
  - Do not close the web page.

- When software update is completed properly, the below will be displayed on:
  1. UPLOADING THE UPDATE FILE: COMPLETED
  2. CHECKING THE UPDATE FILE: COMPLETED
  3. WRITING IN THE UPDATE FILE: COMPLETED
  4. COMPLETE UPDATING: PLEASE REBOOT.

9. Click [REBOOT] at the right bottom of the screen.
   The software update is completed and the projector will go into the standby mode.

NOTE:
- If an error occurs during the software update, an error code in below will be displayed in the “UPDATING STATUS” column.
  2001: Failed to upload the file.
  2007: The uploaded file is too large.
  2011: The uploaded file is broken.
  2012: The uploaded file is broken.
  4001: Received no signal of the HTTP transmission.
  The error codes other than above may be displayed.
  If an error is found during the software update, turn on the projector and update the file again.
  When the software update is not completed properly even if you tried to update several times, please consult your dealer.
9 Troubleshooting Check List

Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem more efficiently.

* Print this page and the next page for your check.

Frequency of occurrence □ always □ sometimes (How often?_________________) □ other (_________________)

Power

□ No power (POWER indicator does not light blue). See also “Status Indicator (STATUS)”.
□ Power cord’s plug is fully inserted into the wall outlet.
□ Main power switch is pressed to the ON position.
□ No power even though you press and hold the POWER button.

Video and Audio

□ No image is displayed from your PC or video equipment to the projector.
□ Still no image even though you connect the projector to the PC first, then start the PC.
□ Enabling your notebook PC’s signal output to the projector.
□ A combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys turns the external display on or off.
□ No image (blue or black background, no display).
□ Still no image even though you press the AUTO ADJUST button.
□ Still no image even though you carry out [RESET] in the projector’s menu.
□ Signal cable’s plug is fully inserted into the input terminal.
□ A message appears on the screen. (_________________)
□ The source connected to the projector is active and available.
□ Still no image even though you adjust the brightness and/or the contrast.
□ Input source’s resolution and frequency are supported by the projector.
□ Image is too dark.
□ Remains unchanged even though you adjust the brightness and/or the contrast.
□ Image is distorted.
□ Image appears to be trapezoidal (unchanged even though you carry out the [KEYSTONE] adjustment).

Other

□ Remote control does not work.
□ No obstacles between the sensor of the projector and the remote control.
□ Projector is placed near a fluorescent light that can disturb the infrared remote controls.
□ ID for the projector and for the remote are same.

□ Shut down during operation.
□ Power cord’s plug is fully inserted into the wall outlet.
□ [AUTO POWER OFF] is turned off (only models with the [AUTO POWER OFF] function).
□ [OFF TIMER] is turned off (only models with the [OFF TIMER] function).

□ Parts of the image are lost.
□ Still unchanged even though you press the AUTO ADJUST button.
□ Still unchanged even though you carry out [RESET] in the projector’s menu.
□ Image is shifted in the vertical or horizontal direction.
□ Horizontal and vertical positions are correctly adjusted on a computer signal.
□ Input source’s resolution and frequency are supported by the projector.
□ Some pixels are lost.
□ Image is flickering.
□ Still unchanged even though you press the AUTO ADJUST button.
□ Still unchanged even though you carry out [RESET] in the projector’s menu.
□ Image shows flickering or color drift on a computer signal.
□ Still unchanged even though you change [FAN MODE] from [HIGH] to [AUTO].
□ Image appears blurry or out of focus.
□ Still unchanged even though you checked the signal’s resolution on PC and changed it to projector’s native resolution.
□ Still unchanged even though you adjusted the focus.
□ No sound.
□ Audio cable is correctly connected to the audio input of the projector.
□ Still unchanged even though you adjusted the volume level.
□ AUDIO OUT is connected to your audio equipment (only models with the AUDIO OUT terminal).
In the space below please describe your problem in detail.

Information on application and environment where your projector is used

<table>
<thead>
<tr>
<th>Projector</th>
<th>Installation environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model number:</td>
<td>Screen size: inch</td>
</tr>
<tr>
<td>Serial No.:</td>
<td>Screen type: □ White matte □ Beads □ Polarization</td>
</tr>
<tr>
<td>Date of purchase:</td>
<td>□ Wide angle □ High contrast</td>
</tr>
<tr>
<td>Light module operating time (hours):</td>
<td>Throw distance: feet/inch/m</td>
</tr>
<tr>
<td>ECO MODE: □ OFF □ ECO1</td>
<td>Orientation: □ Ceiling mount □ Desktop</td>
</tr>
<tr>
<td>□ ECO2</td>
<td>Power outlet connection:</td>
</tr>
<tr>
<td>Information on input signal:</td>
<td>□ Connected directly to wall outlet</td>
</tr>
<tr>
<td>Horizontal synch frequency</td>
<td>□ Connected to power cord extender or other (the number of connected equipment______________)</td>
</tr>
<tr>
<td>[   ] kHz</td>
<td>□ Connected to a power cord reel or other (the number of connected equipment______________)</td>
</tr>
<tr>
<td>Vertical synch frequency</td>
<td>Synch polarity: □ (+) □ (−)</td>
</tr>
<tr>
<td>[   ] Hz</td>
<td>□ Separate □ Composite</td>
</tr>
<tr>
<td>Synch type</td>
<td>□ Sync on Green</td>
</tr>
<tr>
<td>□ Separate □ Composite</td>
<td>STATUS Indicator:</td>
</tr>
<tr>
<td>Synch type</td>
<td>□ Steady light □ Orange □ Green</td>
</tr>
<tr>
<td>□ Sync on Green</td>
<td>Flashing light: [   ] cycles</td>
</tr>
<tr>
<td>STATUS Indicator:</td>
<td>Remote control model number:</td>
</tr>
<tr>
<td>Steady light □ Orange □ Green</td>
<td>Projector — PC — DVD player</td>
</tr>
</tbody>
</table>

Signal cable

NEC standard or other manufacturer’s cable?

Model number: Length: inch/m

Distribution amplifier

Model number:

Switcher

Model number:

Adapter

Model number:

Computer

Manufacturer:

Model number:

Notebook PC □ / Desktop □

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, DVD player, Video camera, Video game or other

Manufacturer:

Model number:
TCO Certification

Some models in this product family are TCO certified. All TCO certified models have the TCO mark on the marking plate (on the bottom of the product). To see a list of our TCO certified projectors and their TCO Certification (in English only), visit our website at http://www.nec-display.com/ap/en_projector/tco/index.html
The TCO certification, designed by TCO Development, is an international environmental and ergonomics standard for IT equipment.
In some cases we may post a list of TCO certified models on our website before the TCO mark is placed on the product. This difference in timing is related to the date certification is received compared with the projectors manufacturing date.
REGISTER YOUR PROJECTOR! (for residents in the United States, Canada, and Mexico)

Please take time to register your new projector. This will activate your limited parts and labor warranty and InstaCare service program. Visit our web site at www.necdisplay.com, click on support center/register product and submit your completed form online. Upon receipt, we will send a confirmation letter with all the details you will need to take advantage of fast, reliable warranty and service programs from the industry leader, NEC Display Solutions of America, Inc.